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1. Introduction

Label Cloud is a cloud-based version of the NiceLabel Label Management System. It is an online
application used to ensure label and brand consistency and to remotely monitor the label printing
process in the production environment.

The main management features in the Control Center include:

* Flexible licensing. All NiceLabel clients (design and production users) get licenses from the
Control Center.

* Central event logging. All clients will log their printing activities into Control Center.
* Printer monitoring. Statuses of label printers are continuously reported to the Control Center.

* Managing print jobs. You can monitor statuses of print jobs from connected clients. You can
remotely pause jobs, restart jobs, change their priority and move jobs to secondary printers in
case of issues.

* Proactive alerting. Send out alerts in case of software or printer problems in the production
environment.

* Web management. Concurrent access to management console using standard Web browsers,
Control Center is a web application.

* Revision control system (versioning). Track changes in your files and manage past file
versions.

* Workflows. Align the printing process with your established approval procedures. Enable life-
cycle on the document level.

1.1. About this Manual

NicelLabel Control Center user guide helps you set up and use this module to manage your
NiceLabel-managed printing solution.

The User Guide contains the following sections:
Introduction. Introduces you to the Control Center.
Installation and Activation. Learn how to install and activate the NiceLabel Control Center.

Configuration and Administration. Learn how to set up NiceLabel Control Center and configure its
operation.

Using NiceLabel Control Center: Discusses the user interface and shows you how to use NiceLabel
Control Center from the user perspective.



Technical Support: Access to technical resources and contacting technical support.



2. Configuration and
Administration

2.1. Configuration

2.1.1. Changing Language of the User Interface

Control Center is a Web application and runs in a browser. To change the language in which the user
interface is presented, change language preference of your browser. You can have multiple languages
defined in your Windows preferences. The language at the top of the list is the primary language.
Control Center will be displayed in this language, if the translation is available. If it is not, the next
language is used.

|§ NOTE

If the Control Center is not available in the selected language, it will display in English.

2.1.1.1. Microsoft Internet Explorer and Microsoft Edge

To change the Control Center language in Microsoft Internet Explorer and Microsoft Edge, do the
following:

1. Open Control Center.

2. Select Network and Internet > Internet Options.

< - 1 5 » Control Panel » Metwork and Internet
File Edit View Tools Help

Control Panel Home

AL Network and Sharing Center

. . . View network status and tasks | Connecttoa network | View network compuy;
wstem and Security

® Network and Internet .‘ HomeGroup

Hardware and Sound Choose hemegroup and sharing options

Programs Internet Options

User Accounts Change your homepage Manage browser add-ons Delete browsing hist
Appearance and

Personalization

Clock, Language, and Region

LES:



3. In General tab, click Languages button.

& Intemet Properties ? Pt

General Security Privacy Content Connections Programs Advanced

Home page
(’ To create home page tabs, type each address on its own line.
a
i about:Tabs|
Use current Use default Use new tab
Startup

(O Start with tabs from the last session
(®) Start with home page

Tabs
Change how webpages are displayed in tabs.
Browsing history

Delete temporary files, history, cookies, saved passwords, and web
form information.

[JDelete browsing history on exit

Delete... Settings
Appearance

Colors Languages Fonts

Accessibility

4. If you use Windows 10 or newer, click Set Language Preferences button.

If you use other Windows operating system, skip this step.

& Language Preference

Language Preference

Add the languages you use to read websites, listing in order of
preference. Only add the ones you need, as some characters car
be used to impersonate websites in other languages.

Set Language Preferences

Chang: nguage Preferences will take effect after
restarti browser

Prefix and suffix options

[Joo not add ‘www' to the beginning of typed web addresses

Specify the suffix (for example .net) that should be added to
typed web addresses when you press Ctrl + Shift + Enter.

5. Change the order of language appearance. Place the main language at the top of the list.

If the required language is not in the list already, click Add a language button, select the
language and add it to the list.



ﬁ$‘ Language

File Edit View Tools Help

Control Panel Home

T ﬁi » Control Panel » Clock, Language, and Region » Language

Change your language preferences

Advanced settings Add languages you want to use to this list. The language at the top of your list is your primary languag
Change date, time, or number
formats Addalanguage FRemove Moveup  Move down

English (United
States)

Windows display language: Enabled
Keyboard layout: United States-International

Deutsch
(Deutschland)

Windows display language: Available for downlead
Keyboard layout: German

frangais (France)

Mq——v

6. Close all dialog boxes.

2.1.1.2. Google Chrome

Windows display language: Available for downlead
Keyboard layout: French

To change the Control Center language in Google Chrome, do the following:

1. Click the Options button to the right of the address bar and choose Settings.

Mew tab

Mew window

MNew incognito window Cirl+Shif

Histary and recent tabs

Downloads

Bookmarks

Zoom - 100% =+

Print...
Find...

Maore tools

Edit ut

Copy

Help and about

Exit

2. Click Show advanced settings... at the bottom of the window.

3. Scroll down and click Language and input settings... button.

10



Chrome Settings

Page zoom: 100% -

) Metwork
Settings

Google Chrome is using your computer's system proxy settings to connect to the network.

Change proxy settings...

Languages
Change how Chrome handles and displays languages. Learn more

Language and input settings...

/ o Offer to translate pages that aren't in a language you read. Manage languages

Downloads

oad location: | D:\Dgwi Change...

4. Change the order of language appearance. Place the main language at the top of the list.

If the required language is not in the list already, click Add button, select the language and add
it to the list.

Languages

Add languages and drag to order them based on your preference, Learn meore

Languages English (United States)

English (United States) Google Chrome is displayed in this langua
German This language is used for spell checking
French Offer to translate p a

| Enable spell checking Edit custom dicticnary

5. Click Done.

2.1.1.3. Mozilla Firefox

To change the Control Center language in Mozilla Firefox, do the following:
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1. Click the Open menu button to the right of the address bar and choose Options.

Cut

]

Copy O Past

¢
100% + {
< B

Mew Window — New Private Save Page
Window
sl
= O o
v
Print History Full Sereen
Find

Options Add-ons l

2. In Content menu, click Choose button in the Languages section.

[ Genera
Q h

E Content

Content

DRM content

v Play DRM content Learn mare
Pop-ups
v | Block pop-up windows Exceptions...

Fonts & Colors
Default font:| Times New Roman « | Size:| 16 - Advanced...

Colors...

Languages \
Choose...

Choose your preferred language for displaying pages

¥

3. Change the order of language appearance. Place the main language at the top of the list.
If the required language is not in the list already, click Select a language to add... drop-down,
select the language and click Add button to add it to the list.
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Languages

Web pages are sometimes offered in more than one language.
Choose languages for displaying these web pages. in order of

preference:
English/United States [en-us] it ve Up
French [fr] E‘ Move Down
German [de] B
Bemove
English [en] e
Select a language to add... - Add
oK Cancel Help

4. Click OK.

2.1.2. Multitier Landscape Management

Increasingly more labeling operations have come to rely on a multitier configuration model as the
most efficient way to stage and deploy the labeling-related files. A multitier approach removes all of
the risks identified in case of a single system landscape, where a single server is used for
development, testing, and production.

In such landscape model, the new labeling solutions are created and test-driven in Development and
Quality Assurance / Testing environments before they are adopted in the Production environment.
Usually a three tier landscape is adopted, or at least two tier landscape, where the roles of
Development and Quality Assurance are merged on the same environment. Each environment
requires a dedicated installation of the Control Center product.

2.1.2.1. File Synchronization Between Landscapes

The synchronization mechanism in Control Center ensures the promotion of approved files from one
landscape to the next. For more information about the synchronization functionality, see the section
Synchronization.

2.1.2.2. Identifying Document Storage in Multitier Landscape

When working in a multitiered landscape, you can configure custom names for each landscape. This
makes it easier to identify to which landscape the current Document Storage belongs to.

Development / QA
Control Center L NLDEMC\nladmin @ Help

# Overview E*RellEhICE 2 Applications & Printers Configurab]e |andscape name in
multi-tier environment i [v]) in [ File name Q] @ [x

< [} SO0 a0

Browse Edit Files & Folders Permissions Revision history Workflo Deleted items | Decommission | Preview
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To configure a custom landscape name, do the following:

1. Openthe application SQL Server Management Studio.

2. Connect to the SQL Server hosting the database of a Control Center for which you want to
define a custom name.

3. Expand the tree-view to reach Databases > <selected database (NiceAN by default)> >
Tables > nan.Setting.

4. Right-click the table nan.Setting and select Edit top 200 Rows.
5. Addanewrecord.
6. For the field Setting enter the value "InstanceName".

7. For the field Value enter the custom name for the current landscape.

Example

The entered custom name in the screenshot above is "Quality Assurance Landscape".

2.2. Administration

2.2.1. Users

2.2.1.1. Adding organizational directory users

If your company uses an organizational directory such as Microsoft Azure Active Directory (AAD), you
can add all included users and groups to the Label Cloud.

The functionality from this section is available in Label Cloud Business and Label Cloud Unlimited.

Connecting to your directory

To connect your Label Cloud to the Microsoft Azure Active Directory (AAD):

1. Signin to the Label Cloud using your Microsoft account. This account must also have AAD
administrative privileges.

@ NOTE

If your Microsoft account does not have administrative privileges on AAD, you
can invite an administrator and let them connect the AAD to Label Cloud.

14



2. Go to Administration > Users > Organizational Directory and click connect.
* AAD connection dialog page opens. Follow the on-screen instructions.
3. Send your colleagues the link to the cloud Control Center.

* By default, the cloud addressis ht t ps: // account . onni cel abel . conf dashboar d
where account is the name of your Label Cloud account.

» After the invited users click the link, they sign in to the Label Cloud using their
organizational Microsoft account.

@ NOTE

Organizational account is a user account that is defined in your company's
organizational directory.

Automatic regrouping of guest user accounts

In certain cases, you might have guest users that you initially invite to the Label Cloud individually, and
later add them to the cloud as part of your organizational directory. Your cloud Control Center
automatically regroups these guest accounts under the organizational users.

* Cloud Control Center removes the guest user account. This is the account that becomes active
after the individually invited user clicks the invitation email link, and completes the sign up
procedure.

* The user's organizational account becomes active in Label Cloud and accessible using the
organizational credentials.

* Cloud Control Center starts displaying the user's organizational display name.

* The user whose account regroups from guest to organizational, retains membership in roles,
and remains an authorized user for the applications they are currently using.

Example

John is responsible for labeling in his company. He receives an invitation to the Label Cloud from a
Nicelabel sales representative. During the testing phase, John individually invites a group of his
colleagues to sign up to the Label Cloud. After the testing phase completes, John asks Mike, the IT
specialist, to connect their company's organizational directory to the Label Cloud. John must first
invite Mike as a guest user. Mike must first sign up and connect the organizational directory to the
Label Cloud. When Mike is done, all existing "testing phase" guest users that are also members of the
connected organizational directory regroup and become organizational accounts.

15



2.2.1.2. Inviting users individually (Guest Users)

You can individually invite your colleagues or external users to participate in your Label Cloud system.
This allows you to share your labels, solutions and configurations within your company and with users
from your partner companies.

The individually invited users join your Label Cloud using their personal Microsoft or Google accounts.
To individually invite users to your Label Cloud:

1. Openyour cloud Control Center and navigate to Administration > Users.

# Overview & Documents @ Applications & Printers @ History -bRIEIET]

Guest users

Administration

> Alerts + Invite guest user

> Security Roles [ | Name Invitation email Status

> Users Active

> Global Variables

Active

2. Toinvite a user, click +Invite guest user.

* The Users page opens.

It Users | Invite guest user Rl | Cancel

> Users Settings

> Access Roles i
Invitation email | lguest@user.com |

> Versioning and Workflows

Personal message to be included in the invitation  [Please join LMS Cloud,

> Database Replacements email y j
Global Variabl

& o Nage Guest User

> Alerts
Notes

> Synchronization

> Account Information
Web applications

Name Description

3. Under Settings, type in the Invitation email address. Other fields are optional. NiceLabel
recommends you to create a descriptive Personal message. Name helps you distinguish the
users later as their number grows. Use Notes to describe the user you are currently adding.

4. Under Web Applications, you can immediately start sharing your label or solution documents
from the cloud Control Center with the invited users.

Web applications

[ | Name Description

@

5. Under Access roles, you can assign the invited guest user the appropriate access role.
Access roles allow you to control the user privileges in your Label Cloud.

16



a. Click +Add. The Add roles window opens. Select the role(s) for your invited user.

b. Click Add.

|§ NOTE

To see the granted privileges for each access role, go to Administration >
Access Roles > click arole > Application Permissions, and expand the list.
Access role details are available in the Control Center User Guide.

6. Click Invite to send the Label Cloud invitation email to the guest user. The invited user
receives the invitation email. Before they can start working with Label Cloud, they must:

* Signinto Label Cloud.
* Download and install the client.

¢ Connect the client to the Label Cloud.

2.2.2. Managing User Privileges

Using access roles helps you keep your entire labeling system secure. You can choose exactly what
access role members can do and see in Control Center and other NiceLabel programs.

Use the Access Roles page in Control Center to set user privileges for your labeling system
according to your own specific security policies. Access roles allow you to assign different sets of
privileges to Control Center users.

Control Center includes default access roles with well-balanced permission sets:

» Administration: All permissions granted. Members in this role have full Control Center
privileges. Administrators can edit default roles, customize roles, and assign roles to users or
groups.

A WARNING

To prevent being locked out of Control Center, be sure you have assigned at
least one Administration role member before you enable or change any
authentication types. This ensures you can log in as an administrator. The local
administrator of the Windows system that hosts Control Center is an
Administration access role member by default.

* Approver: Allows role members to review, approve, or reject labels or solutions in Document
Storage. Approvers send documents to production.

» Approver (second level): Allows role members to review, approve, or reject documents on the
second document approval step. Approvers send documents to production.

* Author: Allows role members to create or edit label templates and solutions. Members in this
role can edit labels and forms, and have control over label production.

17
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* Operator: Allows role members to print labels and run solutions without editing. Members in this
role have read-only access to Document Storage and cannot change any label templates or
application configurations.

* Service Provider: Allows your service provider to access your account for support, setup, and
administration. This role has ho members by default.

* Roles off: When you disable user logons, use this role to set permissions for everyone in
Control Center.

@ NOTE

These default access roles have preset ranges of privileges. You can modify them to
match your company's specific requirements.

To learn how to see and edit default access roles or add new access roles, read Setting up Access
Roles.

Example

John needs full access to Document Storage to upload printing solutions and make them available for
production. Set John's access role to Author.

Annie needs access to the Reports page to prepare reports on printing consumables. You can assign
Annie to any default access role.

Charlie is a printer operator. He only runs solution files in runtime mode and prints labels. Set Charlie's
access role to Operator.

Martha is an account administrator. She needs access to all administrative features. Martha belongs
in the Administration access role.

2.2.2.1. Multiple role membership

If your users or groups are members of multiple access roles, their overall security access sums up
privileges of all access roles.

When your users are members of two access roles, Control Center grants them privileges from their
highest access role, and overrides privileges denied in other roles.

Example

Charlie is a member of Operator and Author access roles. His Operator role grants him read-only
access to Document Storage, but his Author role grants him full access to Document Storage. In this
case, Charlie has full access to Document Storage.
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2.2.3. Setting up Access Roles

You can set up access roles for users in Control Center in two ways. You can edit default access roles,
or create your own custom access roles from scratch.

* Customize default access roles to comply with specific policies or procedures.

* You can keep default roles, use additional customized roles for special use cases, or add new
access roles.

E NOTE

You cannot delete default access roles.

1. To open Access Roles, go to Administration > Access roles.
2. You have two options:
* To edit a default access role, click the role you want to edit.
* To setup a new access roleg, click +Add.
3. Control Center opens the access role configuration page for editing.

a. InSettings, type the role name and description. Make these easy to differentiate from
other roles. For default access roles, you can edit the role description already there.

b. Setthe role Status. Toggle Active to make the role available immediately. Toggle
Suspended to make the role unavailable.

|§ NOTE

Default access roles are always active. You can only change the Status
of new roles you create manually.

c. Settherole Permissions. Define which actions members of this access role can
perform. To learn more about setting permissions, read Setting role permissions.
d. Click Add+ to add users or groups to the access role. A new pop-up window opens.

* Organizational users lists all users that belong to your company's Azure Active
Directory.

* Organizational groups lists all groups that are defined in your company's Azure
Active Directory.

* Guest users lists all users that are invited or have already signed up to the cloud
Control Center using an invitation link.

e. Click Save. Your access role is configured and ready to use.
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|§ NOTE
When you delete access roles, role members lose their permissions.

2.2.4. Setting Role Permissions

Setting permissions for your access roles helps you keep your entire labeling system secure. You can
choose exactly what access role members can do and see in Control Center and other NicelLabel

programs.

S NOTE
NiceLabel recommends using default access roles due to their well-balanced
permission sets. If you configure permissions, consider your security policies and
set permissions for each access role carefully.

For security, your users in different access roles need different levels of access to files, folders, and
actions when they use NicelLabel Control Center. NiceLabel groups common permissions levels into
default access roles. Administrators can customize or create new access roles. Use the Permissions
for this role section in Access Roles to control which actions or settings are available to members of

each access role.
To set access role permissions, follow these steps:
1. Loginto Control Center as an administrator.

2. Go to Administration > Access Roles.

3. Addanew access role or click an existing access role from the list.

The Access roles configuration page opens.

4. Setyour permissions.

The Permissions for this role section includes multiple tabs with lists and detailed descriptions of

permissions for this role.
» To grant specific permissions for this role, check the boxes.

* To disable specific permissions for this role, un-check the boxes.

|§ NOTE
Disabling permissions also makes them invisible to access role members.
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Application permissions

Programs Ferview Documents Applications Printers History and Analytics Administration

-

4|+/| Nicelabel Designer

] Runprogram ) ~.. Functionaltabs of Control
Users can run Nicelabel Designer. Center

v| Edit documents
Users can madify documents. A

~| Print labels
Users can print labels.

~| Run forms
Users can run forms.

4|+/| NicelLabel Print

_—~ Selectto permitordeselectto

preventfrom using actions
~| Run program -
Users can run Nicelabel Print.

V| Print labels
Users can print labels.

~| Run forms
Users can run forms.

* Use the General tab to set global role permissions for your NiceLabel applications and decide
what users in this role can do in your labeling system. For example:

* Run NicelLabel programs:
* Designer
* Print
* Automation
» Edit documents
* Print labels
* Runforms
» Edit global variables
» Edit options
* Upgrade and deactivate licenses

* Use the remaining tabs to set Control Center role permissions. These are permissions users in
this role have when they log in to Control Center. The following permissions tabs correspond to
the navigation tabs in Control Center:

* Overview: Set access to the overview page in Control Center.

* Documents: Set general, default, and custom permissions for document storage:
archiving/restoring, purging, setting workflows, etc.

@ NOTE

To learn more about file access control options, read File Access Control.
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* Applications: Set permissions for web applications and cloud integration management.

* Printers: Set permissions for print queue viewing and management, printer group
configuration, reservations, and cloud printers.

* History and Analytics: Set permissions for viewing errors, alerts, print job logs, label
reprinting, viewing data, and system audit logs.

* Administration: Set multiple administrative permissions for Control Center access role
users.

Click Save to apply your permissions.

Your custom permissions are saved and applied in Control Center and other NicelLabel programs.

2.2.5. Versioning and Workflows

Control Center is a document management system for your labels and solutions. Click the
Documents tab to find all the labels, solution files, and associated files you need for labeling in your
organization.

Because users constantly create and change labels and solution files, Control Center includes two
default access-control mechanisms:

* Versioning ensures your end-users only see only approved versions of labels and solution files.

S NOTE

Control Center considers users with read-only rights end-users.

* Workflows ensure authorized users can participate in the document approval process. Control
Center allows you to define individual users as approvers for various steps in the document
approval process.

To enable Versioning and Workflows for your Document Storage in Control Center, go to
Administration > Versioning and Workflows and toggle buttons to Enabled.

g NOTE

You can enable Versioning and Workflows separately. To use workflows, enable
versioning first.

Control Center allows you to choose your preferred way of revisioning. You can either use:
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# Overview & Documents [ Applications & Printers @ History [l Analytics JECENGIRTEEIdT) .

. ) Document Storage Versioning and Workflows
Administration

> Licenses Document storage settings

thantica / n fi I T
3 Authentication Versioning for document storage Enabled

Access Roles
> Workflows for document storage Enabled

> Application Users

Use only major revision numbers
> Application Groups Dizabled

o

¢ Combination of minor and major revision numbers after you edit and check in your documents.
This is the default option. In this case, minor revision numbers mark smaller user edits while
working on a draft or when applying interim corrections. After the document finishes the
approval process (becomes approved), it gets the major revision number. Leave the Use only
major revision numbers toggle button on Disabled.

> Versioning and Workflows

* If you decide to enable Use only major revision numbers, each checked-in document change
gets a higher major revision number.

If you upgrade your Control Center to version 2019.2 and later, the Use only major revision
numbers option is enabled by default. Previous versions of Control Center only allowed you to
use major revision numbers. The enabled option ensures the continuity of versioning.

To learn more about versioning, read Revision Control System.

To learn more about applying default or custom workflows, read Workflows.

NOTE

Versioning and Workflows are enabled by default.

2.2.5.1. Using versioning

When you enable versioning for document storage, all of your files are included in the revision control
system. Control Center allows you to:

* Work continuously with revisions (versions) of your files. You no longer need to maintain multiple
file versions. With versioning, you have a single file which includes your entire revision history.

» Track changes. Revision history tells you exactly who makes changes to files and when. Using
versioning with workflows makes all your document approval steps available.

* You can revert to previous revisions.
* You can visually compare your revisions.

¢ You can restore deleted files.

To learn more about versioning, read Revision Control System.
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2.2.5.2. Applying workflows

Workflows are sequences of steps that make the correct file versions in your Document Storage
available for your target users. Target users can be print operators, external partners, or any users
who print labels or run solutions.

Control Center comes with 3 default workflows:

* Label Production Approval Process.
* Two-step Label Production Approval Process.

* Label Production Approval Process with Delayed Publishing.

Workflows

Description

The documents will go through the classical approval process.

The docu
scheduled for publishing at 2 later time.

through the approval process. Documents can be

The documents will go through two step approval process. Two unigue
iewers must approve the document.

The number of available steps, transition steps, and user roles are predefined by NicelLabel.
Administrators can customize default workflows.

You can apply workflows to folders in Document Storage.

To learn more about applying default or custom workflows, read Workflows.

2.2.6. Database Replacements

Database replacement values let you change database connections for your labels, solutions, and
Automation configurations when switching between multiple database servers.

@ NOTE

To configure database replacements, you must log on to Control Center as an
Administrator.

Database connection string replacements let Control Center users configure solutions where parts of
database connection strings change while solutions run with connected databases. After running
database connection string replacements, your solution still uses the unchanged database
configuration, but actually connects to a different database server.
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@ NOTE

Database replacements enable users to configure actions in development
environments, and run those actions in production environments without any
database configuration changes.

@ NOTE

Database replacement is possible with solutions and configurations that runin
NiceLabelPrint, NiceLabel Web Client, and NiceLabel Automation.

Configuring database replacements define your "from-to" replacement pairs. Each replacement pair
contains Value from and Value to elements. During actions, Value from strings become Value to
strings. The number of replacement pairs is not limited.

1.

To add new database replacements, open Control Center and go to Administration >
Database Replacements.

Click Add+. The Database replacements page opens.

Type the Replacement name. Make the name descriptive so you can easily find the
replacement later.

The Find text field lets you search for the existing Fr omelement of the replacement pair. This
is the database connection string you are replacing.

Type Replace with. This is the <To> element of the replacement pair. This is your final
database connection string.

Click Save. Your new replacement is active and listed on the Data replacement page.

S NOTE

After you click Save, database replacements require up to 10 minutes to take effect.

Example

Your action in NiceLabel Automation connects to mySQLSer ver and nyDat abase. You want to
update your database connection string to use the database NEW nyDat abase on the server
NEW_ny SQLSer ver .

You must define two replacements - the first changes the server name, and the second changes the
database name.

1. Add the first replacement and name it Server name replacement.

2. Type in the Find text field: Dat a Sour ce=nySQ.Ser ver
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3. Type in the Replace with field: Dat a Sour ce=NEW _ny SQLSer ver
4. Add the second replacement and name it Database name replacement.
5. Type in the Find text field: I ni ti al Cat al og=nyDat abase

6. Type in the Replace with field: | ni ti al Cat al og=NEW nyDat abase

@ NOTE

All database replacements are encrypted in the Control Center database. This
ensures secure replacement of sensitive data, such as user names, passwords and
network addresses.

2.2.7. Global Variables

Global variables are shared among multiple label printing users and printing applications. Global
variables are defined outside the current solution and can be used between different solutions. The
locking mechanism takes care that each print request gets a unique value for the global variable.
Usually, global variables work as unique counters — they automatically remember the last used value
when printing.

Each global variable has a unique internal ID number. This number identifies the global variable within
a solution.

Available actions for the global variables:

» To create a new global variable in Control Center, click Add new global variable.
* To edit the existing global variable, click the pencil button.

* To delete the global variable, click the cross button. Removing global variable is irreversible
process. If you remove a global variable that is still in use in some solution, that solution will raise
an error.

You can create global variables in NiceLabelDesigner or in Control Center. After you design a label or
solution that uses global variables, you must define which global variables are you going to use.
NiceLabelDesigner can either work with global variables that are stored locally in the d obal s. t db
file, or with global variables that you created ad stored in the Control Center.

To select the right source of your global variables in Designer, go to File > Options > Global
Variables. Details on how to create, configure and use the global variables in Designer are available in
NiceLabel 2019 User Guide.
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@ NOTE

To use the global variables from your Control Center, make sure Designer and Control
Center are connected.

2.2.7.1. Setting Global Variable Properties

* ID. This is the internal ID number. This must be a unique number.
* Name. Variable name.
* Description. Optional variable description.

* Current value. This is the value the variable will use next time when needed. You can update the
default value, when needed.

* Prefix/suffix. Prefix is a string added in the front of the variable value, suffix is added to the end.
* Min/max value. Defines the minimum and maximum values the variable can occupy.

* Rollover. Specifies to restart at the minimum value when the maximum value has been reached.
You would use this option for counters.

* Length. Specifies the maximum number of characters the variable can occupy. Enable Fixed
length, when the value must contain the exact number of characters.

« Data format. Specifies the type of characters that are allowable.

» Padding. Specifies the optional characters around the value to fill-in values to the variable
maximum length. You can enter the custom pad character. For example, you would use it to add
leading zeroes to numeric values.

* Increment type. Specifies the counter type. Step determines the value that counter will change
for. Count determines the number of labels upon which the counter will change its value.

2.2.8. Alerts

Alert configuration is done using a Web wizard. The wizard guides you through all essential settings in
4 intuitive steps, prompting the user to enter the required settings for each of the alert types.

TIP

Wizard steps are dynamic and change depending on the type of alert being created.
Each of the alert types requires a different set of information items.

When configuring the event monitoring, select Basic configuration mode and select the type of
raised alerts you want to keep an eye on:
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* NiceLabelDesigner errors during production: if printing from NiceLabel 2019Designer on a
connected workstation reports an error, it raises an alert.

* NiceLabelPrint errors during production: if printing from NiceLabel 2019Print on a connected
workstation reports an error, it raises an alert.

* Automation errors during production: if printing from NiceLabel 2019Automation Builder on a
connected workstation reports an error, it raises an alert.

* License violation: if a license violation is reported from any of the connected workstations, it
raises an error.

TIP

License violation results from exceeded number of allowed printers or from
exceeded number of allowed NiceLabel 2019 installations per license.

The second available option is to select Advanced configuration module using which you can fine-
tune the monitored parameters such as applications, error types, severity and list of workstations you
want to monitor.

After you're done with the alert configuration, send a test alert to check if alerting works in case of a
real emergency. The alert is saved and activated - it begins monitoring the system for the configured
error events. Once an error occurs, the alert sends a notification to the addressee, and the alert event
is logged in the History section. For more information on the event log, see History.

2.2.8.1. E-mail alert

This alert sends a custom email message to the specified email address. You can customize alert
email header and its content.

The suggested (default) message contains all available variables that can be used. The content can
be adapted to fit your purpose during alert setup.

The available email content categories (variables) are:

* Error message: [ErrorMessage]
* Error details: [ErrorDetails]

* Module: [Module]

* Label file name: [LabelFileName]
* Printer name: [PrinterName]

* Error time: [ErrorTime]

* Link to the error: [ErrorUrl]

¢ User: [User]
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* Workstation: [Workstation]

SMTP Settings
Server: smtp.gmail.com
Port: 587
¥ Secure connection Encrypted email connection
parameters.
Username: nlalert@gmail.com
Password:
Sender email: nlalert@gmail.com
Sender name: nlalert@gmail.com
0K Cancel

Nice Control Center 2admin ~ @Help

# Overview @ Documents B Applications & Printers @ History [ Analytics [EAESINMNTEC)

Administration 2. What Kind 3. Who and What
> Licenses
. Please define what kind of alert should be sent. You can also define additional settings for the selected alert type.
> Authentication
> Access Roles Alert type: SMS (via Clickatell G:
Configuring settings to enable SMS

> Application Users alerting type
> Application Groups These additional settings are the same f to define them for every alert.
> Versioning and Workflows

Clickatell SMS Gateway: *
2 Database Replacements

APLID: *
> Global Variables

User name: *
> Alerts

Password: *
> Application Server

* - Required
> Synchronization Previous Next cancel
> Archiving
Commands

[ SMTP Settings

2.2.9. Synchronization

TIP

The functionality from this section is available in Label Cloud Business and Label
Cloud Unlimited.

NOTE

The functions described in this section are available in NiceLabel LMS Enterprise.



The synchronization feature allows you to keep Document Storage from two or more Control Centers
in sync. All changes from the master Document Storage are propagated to the replicated Document
Storage, which contains the exact copy of all published folders and files.

This functionality is frequently used for the following purposes:

* Synchronization of files on geographically distributed locations. In this case you have a
master server set up in the company's HQ. The label design is done centrally. The label approval
is also done centrally. When the labels are approved (and published), they must be distributed to
all production environments. All remote Control Centers are set as clients to the master Control

Center.
CLIENT
CLIENT (EMEA)
(AMERICAS)
DOCUMENT STORAGE
(HQ)
CLIENT
(OCEANIA/AUSTRALIA)

CLIENT
(MIDDLE EAST)

4 9

CLIENT
(AFRICA)

CLIENT
(ASIA)

» Synchronization of files of multiple stage deployments (development > test (Quality
Assurance) > production). In this case, the files must travel in the chain from the development
towards the production environment. Control Center in the Development environment is master
to Control Center in the Test environment and Control Center in the Test environment is master
to the Control Center in the Production environment.

DOCUMENT STORAGE
(DEVELOPMENT)

-

DOCUMENT STORAGE
(TEST/ QA)

]

DOCUMENT STORAGE
(PRODUCTON)
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@ NOTE

When the synchronization is enabled, the Document Storage in the client Control
Center switches to read-only mode. You cannot add & remove folders and files. You
can change the workflow type for the folder and change the workflow steps for the
files within that folder. You can also delete files from the replicated Document Storage.
However, the deleted files are synced from the master Document Storage in the next
synchronization interval.

2.2.9.1. Synchronization Rules

These are the main rules that synchronization procedure will follow:

* The synchronization is always configured and initiated on the client.

* You have to provide the security key that matches the security key on the master Control
Center. The security key will allow access only to the authorized clients. You can click the
Generate Key button to generate your security key, or type in your custom string of characters.

Security

Security key: | ssssanes Show | Generate key

Synchronization Settings . Generate your
[] Synchronize Document Storage from another Control Center sen synchronization key here.

Save changes

* You can only synchronize files that are governed by some workflow process.

* The files that are in the final step of the workflow selected for the particular folder will be
synchronized. The final workflow step is usually approved or published. This depends on the
selected workflow.

* When the source files are synchronized on the client, they are placed in the initial state of the
workflow which is defined for the folder on the client. Although the folder name is the same in
Document Storage on both servers, the workflow process for this folder on the client can differ
from the workflow process on the master.

* File revision number is synchronized as well. When the file in revision 10 on the master is
synchronized with the client, it will retain revision 10 also on the client. Because not all revisions
are approved/published, you can expect to have gaps in the revision numbers on the client.

* File decommissioning makes obsolete published file unavailable for read-only users. When
client Document Storage synchronizes with master Control Center, the decommissioned
approved files are copied from master Document Storage but are no longer marked as
decommissioned in the client Document Storage. To make these files invisible for the read-only
users also in the client Document Storage, decommission them manually. To learn how to
decommission a file, see section Specific access permission options.

* Synchronization service periodically retrieves the list and states of files on the master and
compares them with local copies. New files, files with higher revision numbers, and files which
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have reached the final state in the approval process will be updated in the replicated Document
Storage.

* Synchronization uses its own authentication method and bypasses the authentication mode
configured in the master Control Center. The Control Center deployments do not have to
belong to the same domain. All data exchange is encrypted.

2.2.9.2. Enabling Synchronization

To enable the synchronization, you have to do the following:

1.  Open Control Center page.

2. Go to Administration > Synchronization.

3. Enter the security key (token) as is defined on the master Control Center.

4. Enable Synchronize Document Storage from another Control Center server.
5. Select folder synchronizing option:

* Synchronize all folders: synchronizes all published files and folders of the replicated
document storage with the master Control Center document storage.

* Synchronize the following folders: defines which folders in the replicated document
storage should synchronize with the master Control Center document storage.

TIP

Add each folder in a separate ling, i.e.
/ Label s/ Fol der 1

/ Label s/ Fol der 2

6. Set destination document storage state:

* Document Storage is read only: if enabled, this option makes the replicated document
storage operate in read-only mode. This means that the synchronized folders and
included documents cannot be changed. To allow adding additional folders or files to
the replicated document storage, disable this option.

A WARNING

Synchronized files always overwrite their locally modified copies.

7. Enter the URL to access the master Control Center.
Use the syntax:

http://account. onni cel abel . conf dashboard
.. Wwhere account is the name of your Label Cloud account.
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8. Select time interval in which synchronization must occur. There are two options:

Document Storage Synchronization

Security

Security key: ‘ b19bb3a410384032%dccb0a49b2832b Generate key

Synchronization Settings

¥ Synchronize Document Storage from another Control Center server

Source Control Center server url:| http//server/EP

Synchronize all folders
® Synchronize the following folders:

fUser Guide

¥ Document Storage is read only

Synchronization Scheduling

® Daily at o100~

Periodically every | 1 hours M

Save changes

* Daily. The synchronization will occur daily at specified time. You can select one
predefined value, or enter your own time.

* Periodically. The synchronization will occur periodically in defined time interval
(minutes, hours or days).

9. Click Save changes.

2.2.9.3. Logging Synchronization Activity

After each synchronization cycle, the information about sync action will be added to the Application
event log. The report will contain the following information:

» Start time of sync.
* End time of sync.

* The list of synchronized files (file name, revision).

2.2.10. Account Information

Details about your account and the license plan your Label Cloud runs under, as well as information
about the amount of stored data are available on the License Information page.

Account Information contains your Label Cloud account and license plan details:

* Account name is the name of your Label Cloud account.
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 Edition tells you what NicelLabel license plan you are using.
* Printer limitis the highest number of printer seats that the clients in your Label Cloud can use.

* Used printers tells you how many printer seats are currently in use in your Label Cloud. Click the
number to go directly to the Licensed Printers page. This is where you see exactly which printers
are in use.

Label Cloud Notifications Email addresses you add here receive important Label Cloud notifications
for your account. Your account administrator email address is added automatically. You can add more
email addresses on new lines. Remove email addresses to stop receiving notifications.

Document Storage monitors usage of cloud document storage (Documents tab) resources.

* Used space in Document Storage tells you the amount of data stored in your cloud Document
Storage.

S NOTE

The amount of available storage space depends on your current Label Cloud
license plan.

History displays the duration of log data cleanup intervals. Your time interval depends on your
subscription. After this period, your database data is archived. You can download your archived data
for a time period depending on your subscription level.

* Data retention tells you how long the history log is available online. This depend on your
subscription level.

* Download data archive click to download your database data in Microsoft Access format
(.mdb).

Azure SQL database for your content displays information about the cloud dynamic data storage for
your labeling environment. Read more in section Azure SQL database for your content.

2.2.10.1. Cloud database for your content

The Cloud database for your content is an integral part of your Label Cloud. This database allows
you to establish a secure, centralized and universally accessible dynamic data storage for your cloud
labeling environment. This is the database that your Label Cloud users can work with when they
design and share their labels or solutions.

Example

If you are designing food labels with automatically highlighted allergens on the ingredients list, you
can store the allergens' data in your Cloud database. At print time, your NiceLabel client (Designer,
Print, or Web Client) retrieves the data from the Cloud database, and prints the labels with highlighted
ingredients that are marked as allergens.
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@ NOTE

The amount of available database space depends on your account. Please contact
your NicelLabel sales representative for more details.

To make the Cloud database for your content ready:

1.  Go to Administration > Account Information > Cloud database for your content.
2. Click the Create labeling database button. The New labeling database window opens.

3. Typeinyour user name and set the password. You will need these credentials later when
connecting to the Cloud database from your labels, solutions, or configurations. The

credentials are also mandatory if you want to connect to the database using your database

editing software.

@ NOTE

You can connect to the Cloud database using any compatible SQL tool.
NiceLabel recommends SQL Server Management Studio.

4. Click Create. After a few moments, the window closes. Your database is ready. The
information in the Cloud database for your content section displays:

» Status: creation date of your Cloud database.

» Connection string example displays the connection string format for your Cloud
database in the cloud. To connect your NicelLabel clients this database, adapt the

example connection string with your Label Cloud account user name and password.

To connect to your Cloud database:

S NOTE

Before you continue, install Microsoft SQL Management Studio on your computer.

1. Open Microsoft SQL Management Studio.

2. The Connect to Server window opens. Copy the Server name from Connection string
example.
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Connection string example a8 abelcloud-sql-production-deploci -user.database.windows.netd I R eV ol Br L A
Security Info=False;User ID={yobg_username};Password=
fyour_password}:MultipleActiveRestlSets=False:Encrypt=True;TrustServerCertificate=False:Connection
Timeout=30;

Y

af Connect to Server

SQL Server

Copy server name

Servertype: Databass Engne v
Server name Iabelcloudsqlproduction-deploc T-user.database. windows .y
Authentication SQL Server Authentication
Login I v
Password

[] Remember password
Paste server name

Cancel Help Options >>

3. Set Authentication to SQL Server Authentication. Type in your database credentials.

4. Click the Options >> button. Open the Connection Properties tab. Copy the database name
from the Connection string example to the Connect to database field.

Status Created on 28.06.2019 at 08:18

Cannection string example Server=labelcloud-sqgl-production-deploc1-user.database.windows.net;Initial Catalog={jE Persist
Security Info=False;User ID={your_username};Password=
{your_password}:MultipleActiveResultSets=False;Encrypt=True:TrustServerCertificatg#False;Connection
Timeout=30;

[

4

Copy database name

5'3 Connect to Server

SQL Server

Logn | Commection Properties | Additional Cannection Parameters

Type or select the name of the database for the connection

Connect to database: eftess
Network

Netwark protocol <default>

Network packet size 4096 bytes
Conmaction Paste database name

Connection time-out 1% | seconds

Execution time-out 0 3| seconds

[] Encrypt connection

Trust server certificate

[] Use custom color: l:l

Reset Al

Gomea | [ Consel_| [t

5. Click Connect. You can now work with the Cloud database.
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3. Using Control Center

3.1. Opening Control Center

NiceLabel Control Center application is designed as a web page, to capitalize on the benefits of
remote and centralized access offered by such application design. To start NiceLabel Control Center,
open your browser and type in the following address.

http://account. onni cel abel . conf dashboard
... Where account is the name of your Label Cloud account.
First time sign in to cloud Control Center

When signing in to Label Cloud for the first time, you have to activate your account first using the sign
up procedure.

If you interrupt the sign up after clicking the link, contact NiceLabel sales to receive a new invitation
email, and repeat the procedure.

The sign up procedure is necessary only during your first time sign in.
Complete these steps:

1. After youreceive the Label Cloud invitation email from your NicelLabel sales representative,
click the sign up link.

2. Thelink takes you to the account sign in page. Sign in with your Microsoft or Google account.

- oIl
° I https.//login.onnicelsbelcom/Acco. © - @ © ||| ogin.onnicelabel.com 8

Sign in to your Label Cloud account

If you don't have Microsoft or Google account yet, create a new one following the on-screen
instructions.

3. After signing in successfully, click Continue.

4. The cloud Control Center page opens in your browser.
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Normal signin

After activating your Label Cloud account, you only have to sign in each time you start working with
your cloud Control Center.

To sign in to your cloud Control Center:

1. Goto the Label Cloud sign in page. By default, the page is accessible at:
https://account.onnicelabel.com/dashboard, where account is the name of your Label Cloud
account.

2. Sign in with your Microsoft or Google account.

If you own multiple Microsoft or Google accounts, pick the one that you used for activating
the Label Cloud.

3. Type password and click Sign in.

4. The cloud Control Center page opens.

The visibility of the tabs depends on the user privileges.

3.2. Overview

When you open the NicelLabel Control Center, the Overview page opens. It is s a summary page that
displays the current system status:

* Subscription Status gives you license use information:

 Edition shows what kind of license is active for your Label Cloud. To read which features
does certain edition allow you to use, visit the NicelLabel feature overview web page.

» Used printers tells you how many printer seats are in currently in use. The Label Cloud
license counts the used printer seats. You can print on as many printers as your license
allows you to.

* Operational Workstations within the Last Hour tells you how many computers with NicelLabel
applications that are signed into your Label Cloud have been active during the last hour. If the
NiceLabel 2019 is signed into the Label Cloud, the cloud Control Center automatically starts
tracking its actions and events:

Workstation is the name of the computer that runs NiceLabel 2019 signed in to the Label
Cloud.

Recently Printed is the number of print jobs.
* Last Print is the time of the last print job.

* Recent Errors gives you the number of reported errors.
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S NOTE

If you click the magnifier icon next to the header row, Control Center redirects
you to the History tab. This is where you see the details for each event.

* Recent Errorsis a detailed list of errors reported in the last 24 hours from computers signed in
to Label Cloud.

« Download Client. Click the links to download and install NiceLabel 2019 and NiceLabel Web
Client on your computer.

Control Center - SignOut  @Help

L UV O Documents @ Applications & Printers @ History %8 Administration

Overview

Quickly access an overview of recent printing activity and server information.

Subscription Status

Download Software

Edition: Label Cloud Business NiceLabel 2019

NiceL:
Used printers: 17 / 100 printer(s)

Operational Workstations within the Last Hour

‘Workstation Recently Printed Last Print Recent Errors.

Mo workstations connected.

Recent Errors

Type Module Workstation User Status Submitted ~

Label Print Micelabel Print Spooling failure  9/27/2018, 8:09:37 AM

0 PRODUCT LEVEL INFO:

NiceLabel Automation is available with Label Cloud Business and Label Cloud
Unlimited editions.

3.3. Documents

3.3.1. Document Storage

Control Center includes the document storage feature, which is a shared file repository on the server,
from where the users can store and retrieve their files. While the basic functionality may resemble a
shared location on a network, this storage is on a web-based application. It can be shared to a much
broader public and accessible from anywhere in the world, not limited to local area network.

Document Storage supports all file extensions, not just NiceLabel-related file types.
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NOTE

Availability of options shown on the screen shot depends on the Control Center
product edition.

This section explains how to:

» Work with your Document Storage.
 Search for files and label data.

* Preview your labels.

* Move the files.

» Get file properties.

* Access your files.

* Open files using WebDAV or HTTP syntax.

* Access the database files in your Document Storage from Web Printing.

3.3.1.1. Working with Document Storage

You can control the Document Storage items using commands in the Toolbar above the contents

area. The Toolbar mimics the functionality of a ribbon and uses icons that are easy to understand.

* You have to upload the files into the Document Storage, before you can use them.
* You can organize files into folders.

* You can select the item display mode from icon to list view.

* You can preview all label files. The image preview will appear in a dialog box.

* You can right-click the items to execute commands upon them and see their properties.
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* You can download NicelLabel 2019 directly from the Document Storage and install it on your
computer.

Control Center

A Overview W*JIJaMINIE 2 Applications & Printers

Download Nicelabel 2019
€ c

Client download link

~ i@ Root T T e
@ Adding new clients

b T Anchan

|
1file.exe Intermec_PC43  miha_test.nlbl
b

The commands in the Toolbar change if you enable functionality that is not enabled by default, such
as revision control, workflows, and access permissions.

@ NOTE

You can also right-click folder and files, and use commands in the context menu.

TIP

For best user experience using the Document Storage, make sure to install the
Browser Extension, when prompted so.

Document Storage remembers which was the last viewed folder during your most recent session.
This makes your work with stored documents easier and more time efficient.

After you view a certain folder and leave Document Storage, Control Center will automatically select
the same folder next time you visit Document Storage.

3.3.1.2. Searching for Files and Label Data

If you have to find a particular label file either based on the file name mask or filtered by some
content, you can use the search pane in the Document Storage.

When used, only the files that contain entered string (in the file name or in the file contents) will be
displayed. The folder tree also shows only the folders that match the search criteria or contain sub

items (file or sub folders) that match the criteria. You have to press <ENTER> to confirm the entered
string.

» Search by file name. When you enter a string, Document Storage filters out the displayed items.
You will see all folders and files that contain the entered string in their names.

» Search by file contents. When you enter a string, Document Storage will display the label files
that contain the string anywhere in their content, such as all fixed content for text and barcode
objects and names of all variables (and their description, default value and prompts).
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To clear the filter, click the Clear search button.

When the Document Storage displays filtered results, this is indicated by a different color of the
search toolbar. All files are again shown when you click the Clear search button or presses <ESC>
key.

@ NOTE

The partial search is enabled by default. When you enter word lab, the result will
include label and laboratory. To disable partial search, enter the keyword inside the
double quotes, like this "lab".

You can narrow your search by enabling the advanced searching functionality.
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In this case you can search by specific fields either inside the label meta-data, structural information
or workflow steps.

Advanced search functionality allows search queries, such as the following:

» Find all files that contain string LV in the file name and have text object containing text Batch.

* Find all files that need to be approved (search for by specific workflow step name, such as
Request approval).

¢ Find all labels with dimensions 10x7 cm.

User can enter the following search keys for advanced search functionality:

Example

Name, Author, Description, PrinterName, PrinterDriver, Width, Height, WorkflowStep, Object,
ObjectContent, Text, TextContent, TextFont, Barcode, BarcodeContent, BarcodeType, Graphic,
GraphicPath, Variable, VariableDescription, VariableDefaultValue, VariablePrompt
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After the search keys you have to enter color character (;) followed by the actual keyword. You can
search by concurrent fields, make sure to delimit them with space character.

The following example searches for label that contains both MyPrinter and 660 in the printer name
and contains a variable named Counter1. Label must also contain an EAN barcode.

Example

PrinterName:MyPrinter PrinterName:660 Variable:Counter1 BarcodeType:EAN

Last 10 search terms are saved and suggested to the user when he starts typing in the search field.

Advanced search options *®

All fields:

File name:
Workflow step:
Description:
Author:
Printer:
Object name:

Object content:

Variable name:
Variable default value: Fine-tuning the search
parameters

OK || Cancel
A

3.3.1.3. Previewing Label Files

You can preview the label files directly in the Document Storage without opening the label in designer.
To see the label preview, do the following:

1. Select the label file.

Ig NOTE

You cannot preview solution (NSLN files).

2. Click the Preview button in the Toolbar.
You can also right-click the label file and select Preview label in the context menu.

Preview label (Product label.nibl) x

Variables (=] Preview

D 1030451

Lot ABC123 T Shelf A/B 10,5 C
w20

ProductName Shelf A/B 10.5 C - ABC123

Quantity 10 0

Weight 20

g

Browse for the sample file containing label
data as name:value pairs
Live label preview displaying the entered
values for the variable objects

Close
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Control Center also preview images and PDF files. Double-click or right-click the file, and click
Preview. You can preview files with extensions .omp, .png, .jpeg, .gif, .tif, wmf, .emf, and .pdf.

The preview opens in a new tab of your web browser.

System Test_30584

@ Preview

ﬂ Download

B Cony

M Cut

@ Rename

fu' Remave

[8) Check Out
Revision history
0 Get info

phyTest.misx  Preview.pdf

If you work with file revisions, you can open label previews of any revision from the Revision history
for the selected label.

@ NOTE

When opening the label preview, you can enter the values for variables and see how
they are used in the label template. You can also use values from a data file.

@ NOTE

Label preview is generated by the installed printer. If the printer does not exist, a
virtual printer is used instead.

Applying Values From Data Files to Variables

The label templates are usually designed with variables that don't have any default value defined. This
ensures that there are no hard coded values that would be used during printing. On the other hand it
makes the label preview and comparison more difficult task, because you have to provide the values
for variables before the label preview is generated. When generating the label preview, you can enter
values manually.

You can also provide the external data file with a list of variables and their values and NicelLabel
Control Center will automatically use it for the label preview. The data file must provide the name:value
pairs. There must be name of the variable and there must be value for the variable. All pairs are read
from the data file and values sent to the variables of the same name defined in the label. If the variable
of the same name is not defined in the label, the name:value pair is discarded.
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@ NOTE

You can let Control Center find the data file based on the rules defined below, or you
can click the folder icon next to the label name/preview and override the defaults with
your data file.

Data file structure
The contents for the variable data can be provided in either of the two available structures.
XML structure

The variables are provided within <Var i abl es / >root elementin the XML file. Variable name is
provided with the attribute name, the variable value is provided by the element value.

<?xm version="1.0" encodi ng="utf-8"?>
<Vari abl es>
<variabl e nane="Variabl e 1">Val ue 1</vari abl e>
<vari abl e nanme="Vari abl e 2">Val ue 2</vari abl e>
<vari abl e nane="Vari abl e 3">Val ue 3</vari abl e>
</ Vari abl es>

Delimited structure

The variables are provided in a text stream. Every name:value pair is provided in a newline. Variable
name is to the left of the equals character (=), variable value is to the right.

Vari abl e 1=Val ue 1
Vari abl e 2=Val ue 2
Vari abl e 3=Val ue 3

Data file naming convention

The name of the data file can be the same as the name of the label, but using the extension . val ues.
This private data file allows you to provide different data file for each label.

If you have a label named | abel . nl bl , the data file must be named | abel . val ues.

The other option is to use the same generic data file for all labels. In this case, name the data file
def aul t . val ues. The name:value pairs within will be used for all labels.

E NOTE

If both files exist in the same folder, the file | abel . val ues will take precedence over
the file def aul t . val ues.

Data file location

You can store the data file in various locations in the Document Storage.
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Example

The label | abel . nl bl is saved in the folder / f ol der 1 and therefore available as/ f ol der 1/
| abel . nl bl .

The searching for a data file is executed in the following order.

1. The private data file in same folder as the label file.

Example

[ f ol der 1/ | abel . val ues

2. The private data file in the subfolder SampleValues.

Example

/ f ol der 1/ Sanpl eVal ues/ | abel . val ues

3. The generic data file in the same folder as the label file.

Example

[ f ol der 1/ def aul t . val ues

4. The generic data file in the subfolder SampleValues.

Example

/ f ol der 1/ Sanpl eVal ues/ def aul t . val ues

When the first available . val ues file has been found, the search stops and contents of the data file is
used for the label preview.

@ NOTE

Using the Sanpl eVal ues subfolder is useful when you have a workflow process
defined in the label folder, but you do not want the same workflow to govern your data
files. In this case, you can store the new version of the data file without going through
all workflow steps.

3.3.1.4. Moving Files

To move a file to a different folder while keeping all its revision and associated comments, do the
following:
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1. Select thefile.
2. Click Cuticonin the toolbar.
3. Move focus to a folder into which you want to move the file.

4. Click Paste icon in the toolbar.

|§ NOTE

You can also select multiple files and folders for moving. When you select folders, all
its content is moved (files and sub folders).

3.3.1.5. Getting File Properties

You can obtain the file properties, such as file name, file type, size, creation and modification date,
name of last user that modified the filg, file permissions, selected workflow for this folder, workflow
step in which the file is, check out status and revision number.

To see file properties, do the following:

1. Select the file.

2. Click the Get info button in the Toolbar.
You can also right-click the file and select Get info in the context menu.

3.3.1.6. Accessing Files

Accessing files using browser

You can use Control Center Web interface to interact with files inside the Document Storage. This is
the access method if you want to grant access to Document Storage to users, connecting from
external locations (such as the Internet). In this case, make sure that your firewalls allows inbound
connections to the Control Center.

|§ NOTE

If you have NicelLabel client locally installed, double-clicking the label (NLBL) or
solution file (NSLN) will open it in the Designer. The options to Edit or Print & Run files
is also accessible in the right-click menu.

Accessing files using NiceLabel Client

The users can use the File > Open dialog box in NiceLabel software to interact with the files in the
Document Storage. The users can also use their favorite file manager, such as Windows Explorer.
When you activate NicelLabel client with a license from Control Center, the shortcut to the Document
Storage is added to user's Favorites. This shortcut becomes accessible in Explorer and every
Windows file-managing dialog box.
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NOTE

If you are using the application authentication on your Control Center, the users that
work with NiceLabel 2019 applications, must type their credentials each time they
start Designer, Automation or Print.

3.3.1.7. Opening Files Directly

Using the HTTP syntax

You can

htt ps:

use the following HTTP syntax to open files:

| | <account >. onni cel abel . com 8080/ f ol der /| abel . nl bl

3.3.1.8. Using Custom Fonts

If your company is using custom fonts for labeling, you can upload and store these fonts in your
document storage. This is how you can store your custom fonts on a universally accessible and

manageable central location.

The dedicated font storing location in your document storage is/ Syst enf Font s. This where your

Control

Center takes the fonts for label previews.

To upload your custom fonts to document storage:

1.

Go to Documents tab > System > Fonts folder. If the Systems folder does not exist yet,
create one at the root level and create a subordinate Font folder.

/i Create System folder

s gakae (a

v/l Root
& Graphics | | |

i Labels Graphics Labels Solutions

@ Solutions

Upload your folders to the System/Fonts folder.

Create System folder

o gaGae (&

~ /@ Root
& Graphics | | |

i Labels Graphics Labels Solutions

@ Solutions

This makes custom fonts ready for your labels.
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@ NOTE

Make sure you have the legal right to use the uploaded custom fonts before you
design and publish your labels.

@ NOTE

You cannot use custom fonts with the Text on ellipse effect. Read the NiceLabel 2019
User Guide for more details.

|§ NOTE

To use custom in the Rich Text Box object, make sure you enable the Alternate
rendering option. Read the NiceLabel 2019 User Guide for more details.

3.3.2. File Access Control

Set access permissions to your individual folders with file access control. This is useful when you
want to limit access to certain folders in Document Storage to specific groups of users. You can
customize access permissions for folders and subfolders by specific access roles and apply them to
all role members.

3.3.2.1. Access Control Rules

These rules define access control in Document Storage:

* You set access control for folders with access roles. Users can be members of multiple roles
that affect how you can read, write, edit, and delete documents in document storage.

* All permissions you set for a folder apply both to folder contents and to subfolders.

» Subfolders inherit permissions from parent folders, or you can set custom permissions for each
subfolder.

3.3.2.2. Additional Workflow-related Access Control Rules

When specific workflow processes apply to folders, these additional rules apply:

* If you have read-only access to a folder, you can only read the last approved-published revision
for files. If files are not yet approved-published, you cannot read them at all. Configure access
privileges by access roles.

49



S NOTE

Users in production environments must have read-only access to ensure they
see only approved-published revisions.

* When you have full folder access (read and write permissions), you can read any file revision.

3.3.2.3. Changing access permissions for folders

Access permissions for folders depend on user roles. To set general access permissions or custom
permissions for specific folders and subfolders, use access role permissions in Control Center.

@ NOTE

Make sure you enable user login for Control Center.

You can set folder permissions by selecting individual folders in Documents or by editing Access

Roles.

To change folder permissions from Documents:

1.

2.

Go to Control Center > Documents.

Right-click the folder you want to edit and click Folder permissions. Your folder permissions
window opens.

Click Edit near the role you wish to edit. The Access Role permissions page opens.
Choose the permissions you wish to change and click Customize.

Click Save.

Your new folder permissions now apply to your selected folder.

To change folder permissions from Access Roles:

1.

2.

Log in to Control Center as an administrator.

Go to Administration > Access Roles and click a role to customize from the list. To add a new
role, click + Add.
The Access Role configuration page opens.

Go to Permissions for this role > Documents tab to set:
* General document permissions for all folders

* Default document permissions for all folders, including storage and workflow
permissions

To set custom permissions for specific folders or subfolders, go to Custom document
permissions.
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5. Select afolder to customize and click Customize.
Control Center opens the Customize permissions dialogue for the folder you select.

6. Click specific storage and workflow permissions to apply to this role and folder.

@ NOTE

Access role settings you change for this folder apply to all users in the access
role.

7. Click Customize.
Permissions you set for this role and folder now display in the Custom permissions section of
Custom document permissions.

8. Click Save (on your top right) to save your settings and continue working.

Custom folder permissions you set are saved and now apply for all access role members.

3.3.2.4. Specific access permission options

S NOTE

The functions described in this section are available in NiceLabel LMS Enterprise.

Decommissioning a File

If a published label or solution file becomes obsolete during its life cycle, decommissioning allows you
to make the file unavailable for read-only users. Decommissioning makes deleting an obsolete file
from the document storage unnecessary. This option just hides the obsolete file and, if necessary,
makes it available again using recommissioning.

To decommission a file in the Document Storage:

1. Right click the file to display the context menu and click Decommission. The confirmation
window pops up.

51



Document Storage
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ﬂ Download
B Copy
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@ Rename

ﬁ]' Remove
@ Check Out

Decommision a Revision history

. &% Workflow step
fl Ie Decom%ission
Q Preview label
Label Report
% Compare
€) Getinfo

2. Click OK to continue. The confirmation window opens. Type in the reason why you are
decommissioning the file.

After you have decommissioned the file, an icon appears next to the file in the Document
Storage (see the green arrow in the picture below). This icon indicates that the file is no longer
visible to the read-only users.

Ig NOTE

You can decommission a file even if it is not currently published. This option is
available also for files that are still in approval process or have been
unpublished in the past.

If you decide to make the decommissioned file visible again, recommission it:

1. Right-click the document to display the context menu and click Recommission.
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2. Click OK to continue. The confirmation window opens. Type in the reason why you are
recommissioning the file. The file is again visible to the members of access roles with read-
only privileges.

@ NOTE

Authentication must be enabled on Control Center to make file decommissioning
possible. Supported authentication types are: Windows, Application and External
authentication.

|§ NOTE

You can view the decommissioning/recommissioning actions and their details in
Control Center history.

By default, members of Administrator and Approver access roles are allowed to decommission files.

To allow other user roles to perform this action, go to Administration > Access Roles > select the

access role > Application Permissions > Control Center. Scroll to Decommission files in document

storage to allow or deny this option to the members of this access role.

53



Privileges

Administration
Nicelabel Designer
Nicelabel Print

Nicelabel Automation

LY ¥ Ow

Control Center
View Events
View Alerts Configuration
Manage Alerts Configuration
View Alerts Log
View Print Job Log
View Print Queues

Manage Print Queues

Configure Printer Groups
Reprint Access
Overview Access A

Reports Access
Decommission files in document storage /

Remaove published files in document storage

3.3.2.5. Removing published files

By default, only members of Administrator access role can remove a published file from Document

Storage. However, the Administrators can allow any other access role to remove the published files.

To grant the selected access role the right to remove published files from Document Storage, go to
Administration > Access Roles > select the access role > Application Permissions > Control
Center. Scroll to Remove published files from Document Storage and select this option.

Privileges

Administration
Micelabel Designer
NicelLabel Print

Nicelabel Automation

LY ¥ OW

Control Center
View Events
View Alerts Configuration
Manage Alerts Configuration
View Alerts Log
View Print Job Log
View Print Queues
Manage Print Queues

Configure Printer Groups

Reprint Access
Overview Access h
Reports Access

Decommission files in document storage

Remove published files in document storage

|§ NOTE

You can remove an entire folder that contains published files. If you do not have the
permission to delete the included files, an error dialog with a list of files that cannot be
deleted pops up.
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3.3.3. Label Report

You can use label report feature to create a detailed description about the structure of the selected
labels. At the same time, the label preview is generated for the visual reference on the label design.

When the label report is selected, a new tab will open in the browser and will contain detailed
information about the selected file(s). You can initiate the report on the single file, group of files, the
contents of the entire folder and on the specific revision of the label file.

The report will contain label's meta-data (name, author, description and commit comment), label
structural information (list of fixed objects and variables with their contents), and label preview. You
can use the provided information to build a label catalog, a list of all labels you use in your
environment. This will help you keep track on the number of labels, their structure and intended
usage. Before creating a new label template, you can verify your label catalog if a similar label has
already been created. You could use the existing label as a master template for a new label.

If you need the label information saved in your existing business & informational system, you can
download the provided label structure in the XML file and upload it to your system.

g NOTE

If you have generated report for several labels, you can download XML files for
individual labels, or one XML file containing definition of all displayed labels.
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Label name: hitp://FATA:B080/User Guide/Product label.nlbl
Description:

Revision number: 2

Commited by:

Commit comment: checkin

Printer name: SATO CLG608e

Printer driver: SATO CL&08e

Label dimensions (width, height): 100 mm, 70 mm
Workflow ;tep: Approved

Label metadata

Workflow step log

Date User Data
10/12/2016 1:42:40  Anonymous Draft -> Request approval
PM Workflow: Label production approval process
10/12/2016 1:42:49  Anonymous Request approval -> Approved
PM Workflow: Label production approval process
Text fields
Name Font Size
Text Arial 10 pt
Text_1 Arial 10pt
Text_1_1 Arial 10pt
Text 12 Arial 10pt
Text_13 Arial 10pt
Text.2 Arial 10pt
Text_3 Arial 10pt
Text 4 Arial 10pt
Bar codes
Name Type
Barcode Code128
Graphics
Name Path
No items for this group
Variables P -,
iz List of label variables
D o anq

and their initial values
Lot
ProductName
Quantity
Weight

Product name: Shelf sample

Weight: 10
LOT. ABC123D

Quantity: 10

Label preview with L o
- l””l"””lw |‘|||H ”ll“ ”“|| |‘|
‘ nr

Comment

Approve please.

Approved.
Workflow events

Content
Product name:
Weight:
LOT:

Quantity: —
Structural information )

about label

Content
123456789012

Default value Prompt
AB1238

ABC123D
Shelf sample

10

=

0 Export label data to XML

" Download XML

3.3.3.1. Executing the Label Report

You can invoke the label report from several locations within the user interface:

1. Onthe selected label file(s). You can select one or several label files, right-click on them and

select Label Report. The report will display in another tab inside your browser.

To select several files clickand hold Ct r | key while selecting files.
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2. Onthe selected folder. Select the folder, then right-click it and select Label Report. The
report will be generated for all label files in this folder and all its sub folders.

@ Solutior
b [ TestDir
b T TestFol g New folder
b @ TestFol Ej Mew project
b T TestFol [ Upload files
b [ TestRer O Workflaw
@ TwoSte
@ User Gi

3 Reload

@ Check Out
@ Check In
Discard Check Out

Label Report

3. For a specific revision of the label file. In the file revision history window click on the
document icon to create label report for that particular revision of the label file.

File revision history (Label_Step1.nlbl) »®
8 Revert 4/4/2019 5 KB Label production Draft a Q @ -
9:01:35 AM approval process
7 Revert 4/4/2019 5 KB Label production Draft a Q 0]
9:01:05 AM approval process
[ Revert 11/14/2018 Anonymous 5 KB MSG Draft s Q ®
3:04:59 PM
5 Revert 11/14/2018 Anonymous 5 KB MSG Draft a Q
3:04:30 PM
4 Revert 11/14/2018 Anonymous 5 KB MSG Draft a a @
2:59:33 PM
3 Revert 11/14/2018 Anonymous 5 KB MSG Draft a Q o
2:53:04 PM
2 Revert 11/14/2018 Anonymous 5 KB Label production Draft =) Q @
10:49:56 approval process

o
®

Initiating label report for the selected label revision

Compare revisions = Close

3.3.3.2. Label Report Contents

For each label document, the following contents will be shown:

Label meta-data



* Labelname

* Author (the user that last uploaded or modified the document in the Document Storage)
+ Title

* Description

* Revision number

* Committed by

* Commit comment

* Printer name

* Printer driver name

* Label dimensions (width, height)

* Current workflow step

Preview label

» Label preview provides preview of the saved label with assigned data.

Label preview is generated by the installed printer. If the printer does not exist, a virtual printer is used
instead.

@ NOTE

If a stored label has Prevent font replacement option enabled, label preview
becomes unavailable in case of missing fonts. See NiceLabel Designer User Guide for
details.

Label contents

* Workflow step log. Logged information related to the assigned workflow: date, user, data,
comment.

S NOTE

This segment is visible only if the workflow is set for the selected document.

* Properties of all fixed text objects. Object name, font, size, content.
* Properties of all fixed barcode objects. Object name, barcode type, content.
* Properties of all fixed graphic objects. Object name, path and file name to the used image.

* Properties of all variables. Name, description, default value, prompt.
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3.3.4. Comparing Label Files

NOTE

The functions described in this section are available in NiceLabel LMS Enterprise.

This feature provides an ability to graphically compare different label files, or different revisions of the
same label file.

Graphical comparison is a great tool whenever you are interested in the changes between label
designs. This information might already be provided in the comment field required during each check-
in process, but perhaps the detailed level is not satisfactory. The tool will display all selected labels
and/or revisions of a single label as thumbnails. You can select the left and right label/revision for
comparison. Both selected labels will display on top, followed by a third image of both preview
superimposed.

The color-coding allows for all differences to be easily spotted.

Left preview - Revision: 3 Right preview - Revision: 2
FROMCTIYE Shelf A/B 10..5 C OCTIEE Shelf A/B 10..5C
WEIGHT 2-0 WEIGHT 2-0
“ ABC123 E “r ABC123
QUANTITY 10 QUANTITY 10

Comparison

\ Displaying the selected revisions
|

PRSI Shelf A/B 10..5C

WEIGHT 2 | 0 - ...:
< ABC123 s
QUANTITY 1 0 s

Color-coded changes between the |I| |II| I || | || I||

selected revisions forthe easy
identification
L J
Document revisions - Product label.lbl (
Revision: 3 Revision: 2 Revision: 1 / Selecting the revisions for
companson
T Shell AB10.5C T Shelf A/B 10,5 C =
= 20 = 20 =T 20
ABC123 g h ABC123 ABC123
- 10 - 10 - 10
C - @B
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@ NOTE
Graphic comparison is available for label (.NLBL) files only.

3.3.4.1. Comparing Different Label Files

To compare different label files, do the following:

1. Select two or more labels in the same folder.

Ig NOTE
Hold Ctrl key while clicking labels to select multiple labels.

2. Right-click the labels and select Compare.
B8 &) @ 3 il

Counter.lbl graphi
ve B Copy

¥ Cut

-3
Wl Remaove

Label Report
|-|_'_‘| Compare

0 Get info

3. Select the left and right label for comparison. The superimposed image of label differences
will be shown below the preview of the two selected labels.

3.3.4.2. Comparing Revisions of the Same Label File

To compare revisions of the same label file, do the following.

1. Right-click the label that has at least two revisions and select Compare.

60



B0 G 00

H-m Edit

Counter. bl grapl
v B Print

ﬂ Download
@ Copy

¥ Cut

@ Rename

|.T|.|- Remave
[3) Check Out

Revision history

q Preview label
Label Report
% Compare
0 Get info

2. Select two revisions for comparison. One for the left preview, one for the right preview. The
superimposed image of label differences will be shown below the preview of the two selected
labels.

Applying values from Data Files to Variables

The label templates are usually designed with variables that don't have any default value defined. This
ensures that there are no hard coded values that would be used during printing. On the other hand it
makes the label preview and comparison more difficult task, because you have to provide the values
for variables before the label preview is generated. When generating the label preview, you can enter
values manually.

You can also provide the external data file with a list of variables and their values and NiceLabel
Control Center will automatically use it for the label preview. The data file must provide the name:value
pairs. There must be name of the variable and there must be value for the variable. All pairs are read
from the data file and values sent to the variables of the same name defined in the label. If the variable
of the same name is not defined in the label, the name:value pair is discarded.

|§ NOTE

You can let Control Center find the data file based on the rules defined below, or you
can click the folder icon next to the label name/preview and override the defaults with
your data file.

Data file structure

The contents for the variable data can be provided in either of the two available structures.

XML structure

The variables are provided within <Var i abl es / >root elementin the XML file. Variable name is

provided with the attribute name, the variable value is provided by the element value.
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<?xm version="1.0" encodi ng="utf-8""?>

<Vari abl es>
<vari abl e nane="Vari abl e 1">Val ue 1</vari abl e>
<vari abl e nane="Vari abl e 2">Val ue 2</vari abl e>
<vari abl e nane="Vari abl e 3">Val ue 3</vari abl e>

</ Vari abl es>

Delimited structure

The variables are provided in a text stream. Every name:value pair is provided in a newline. Variable
name is to the left of the equals character (=), variable value is to the right.

Vari abl e 1=Val ue 1
Vari abl e 2=Val ue 2
Vari abl e 3=Val ue 3

Data file naming convention

The name of the data file can be the same as the name of the label, but using the extension . val ues.

This private data file allows you to provide different data file for each label.

Example

If you have a label named | abel . nl bl , the data file must be named| abel . val ues.

The other option is to use the same generic data file for all labels. In this case, name the data file
def aul t . val ues. The name:value pairs within will be used for all labels.

@ NOTE

If both files exist in the same folder, the file | abel . val ues will take precedence over
the file def aul t . val ues.

Data file location

You can store the data file in various locations in the Document Storage.

Example

The label | abel . nl bl is saved in the folder / f ol der 1 and therefore available as/ f ol der 1/
| abel . nl bl .

The searching for a data file is executed in the following order.

1. The private data file in same folder as the label file.
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Example

[ fol der1/ | abel . val ues

2. The private data file in the subfolder SampleValues.

Example

/ f ol der 1/ Sanpl eVal ues/ | abel . val ues

3. The generic data file in the same folder as the label file.

Example

/ f ol der 1/ def aul t . val ues

4. The generic data file in the subfolder SampleValues.

Example

/ f ol der 1/ Sanpl eVal ues/ def aul t . val ues

When the first available . val ues file has been found, the search stops and contents of the data file is
used for the label preview.

|§ NOTE

Using the Sanpl eVal ues subfolder is useful when you have a workflow process
defined in the label folder, but you do not want the same workflow to govern your data
files. In this case, you can store the new version of the data file without going trough all
workflow steps.

3.3.5. Revision Control System

E NOTE

The functions described in this section are available in NiceLabel LMS Enterprise.

Document Storage implements the revision control system for the labels, images, and related files.
Over time, you will have a complete history of your files. The system allows you to work with revisions
(version) of files, track changes made to the files, revert to the previous revisions, and restore deleted
files.
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Every time a designer wants to work with a label file, the file must be checked-out to the user. At this
time, the file is locked to that user. Any other user can open the file in read-only mode only. When the
designer checks-in the file, the new file version is created in the Document Storage. The revision
number increments by one after each Save operation. The first file version is revision 1, the second
revision 2, and so on. All previous revisions of the file are still available in the database. The designer
can always access previous label revisions and make them active. For each check-in operation, the
user can enter a comment describing the changes in the label design.

3.3.5.1. Adding files to Document Storage

S NOTE

Files you upload must be smaller than 100MB.

You must first upload files to the Document Storage to make them available for users:

1. Click the Upload files button in the Toolbar. The upload dialog opens.

2. Dragthe files or folders to the upload dialog. You can also click the upload dialog to browse
for the files that you want to upload.

* Enable Overwrite existing files if you only want to keep the latest uploaded file version
visible in your Document Storage.

S NOTE

If you disable the Overwrite existing files option, Control Center
prevents uploading files with identical names. If you try to upload a file
with identical file name, an error appears.

Each time you overwrite an existing file, you raise its revision number.

@ NOTE

To keep all file versions available, enable Versioning for your Control
Center first.

» Use the Comment field to add a description about the newly added files or folders or
their versions.

3. Enter the optional Comment. The Comment is recorded to the file log.
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Choose Files | label replacement.nlbl
Choose Files | multiline.nlbl

Choose Files | Mo file chosen

@ Add field

¥ Overwrite existing files

Comment:
Initial version of the label files

Uploading files to the
Document Storage

Cancel

4. Click OK. Your files are ready in the Document Storage.

3.3.5.2. Checking Out Files

Before you can start editing the file, you have to check it out from Document Storage. The checked-
out file is marked and locked for editing for any other user. All other users will see the current revision
of the file, while the designer already works on a new draft. You can check out file from a Designer or
from the Control Center.

To check out file from NiceLabel Designer, do the following:

1. In NiceLabel Designer, open the file from the Document Storage.

2. In Document Storage ribbon, click Check Out icon.

To check out the file in the Control Center, do the following.

1. In Document Storage tab, select the file you want to check out.

2. Click the Check Out button in the Toolbar.
You can also right-click the file and select Check Out in the context menu.

3. Double-click the file to open it in associated application. E.g. double-clicking the label will
open it in NiceLabel Designer.

To allow other users making changes to the file, you have to check it back in, or discard check out
operation. The methods are available in the NiceLabel Designer and in Control Center user interface.

A WARNING

If you click Discard Checkout, you irreversibly lose all changes that any of the users
did after checking out the file. To keep the changes, check in the labels or solutions
first.

65



3.3.5.3. Checking Out Multiple Files

Use the standard Windows shortcuts with Ctrl key to select individual files. When you click the Check
Out button, all selected files will be checked out simultaneously. You can also select Check Out
command while you have a folder selected, or by right-clicking folders in the navigation pane (on your
left). In this case all files in the folder will be checked out.

If an error happens during the processing, the user is informed about the details.

3.3.5.4. Checking In Files

When you are finished with editing the document, and want to make it available to other users, you
have to put the file back into the Document Storage. The process is referred to by "checking-in the
file". You can check in the file from NiceLabel Designer and in the Control Center.

When you check in the file, the file revision will increment by one. The entered comment is logged to
file log.

To check in the file in NiceLabel Designer, do the following:
1. While the label is still opened in the Designer, go to Document Storage tab in the ribbon.

2. Click Check Inicon.

To check in the file in the Control Center, do the following.

1. If you have downloaded the file and edited it locally, you have to upload the file back into
Document Storage.
If you have opened the file in editor by double-clicking it, the edited file is already uploaded
into Document Storage.

2. Select the file in Document Storage.

3. Click the Check In button in the Toolbar.
You can also right-click the file and select Check In in the context menu.

4. Enter the optional comment. It's a good practice to enter the comment describing the
changes you did in the file.

3.3.5.5. Checking In Multiple Files

To checkin all files in a folder:
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Go to Control Center > Documents.

N

Right-click the folder you want to check in from the navigation pane (on your left).
3. Click Check In. Your Check In window opens.

4. Type a comment describing your changes (for your revision history) and click Check in.

All the files in your folder are now checked in.

@ TIP
You can also click the Check In icon (above) with a folder selected to check in all files
in your selected folder. Comments you type for your revision changes apply to all files
you check in at once.

To check in some files in a folder, use <Ct r | > + click to select multiple individual files and click Check
In.

For any processing errors you see details like: files opened in Designer, file check out discarded,
or file deleted.

|§ NOTE

Your configuration determines who can see your checked-in files.

For example: with workflows enabled, your print operators see only Approved/
Published checked-in files.
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3.3.5.6. File Revision History

Every change to the file is logged to database. Whenever you check-in the document, you can enter
the comment describing the changes. The file revision history includes all events occurring for file,
including revisions and workflow changes.

To see all activities for the file, do the following.

1. Selectthe file.
2. Click the Revision History button in the Toolbar.

3. The dialog box displays all known details, including revision number, data of change, user who
committed the change, size of the file, workflow defined for current folder, workflow step for
the file, and comment.

Download local copies of revisions

File revision history (Label_Step1.nibl)

Revision Date User Size Workflow Workflow step Comment \ﬁ‘ahell_t Prégjew Download
Epol
11 4/4/2019
9:06:47 AM E
Access to Label Report and Preview
10 Revert 4/4/2019 P Q
9:05:46 AM
a Revert 4/4/2019 5 KB Label production Draft a @®
09:02:27 AM approval process
8 Revert 4/4/2019 5 KB Label production Draft a Q @®
pproval process
’ Details about file's life cycle changes ]ﬁgﬁé\%f’g?&e"s"; praft @ E a @
6 Rev SG Draft s =B a ®

3:04:59 PM -

Compare revisions = Close

Access to graphical revision comparison

4. File Revision History provides access to additional commands:

* Revert to label revision. You can revert files to any of their previous revisions. This
action copies the selected file revision and adds it as the latest (current) revision.

g NOTE

Reverting to label revision is reserved for access roles with Read/Write
permissions for the current folder. See how to set access permissions
for folders in section File Access Control.

* Label report. A label structure report will be displayed on-screen, including meta
information about the label including the graphical preview, plus a list of all label objects
and variables. The report can be also downloaded as XML file.

* Preview label revision. You can preview any revision of the label file on screen. Use this
feature to avoid opening labels in the designer, just to see how it looks.

* Download. You can download local copies of all existing label revisions from Document
Storage to your computer. Open the downloaded copies in Designer and use them to
create new revisions.
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* Compare revisions. You can graphically compare the changes from one document
revision to another on-screen.

3.3.5.7. Working with Revisions

The revision control system ensures transparency when reviewing your labels, solutions, or other
labeling assets in the document storage. After each document check-in, your Control Center stores
information about workflow promotions, check-ins, changes, and user comments. Additionally,
Control Center keeps track of who and when performed all the actions.

When checking in your files, you can choose between minor and major file versions. Although there
are no strict rules about when to use minor or major revisions, these are the guidelines:

* Minor revisions mark smaller user edits while working on a draft or when applying interim
corrections.
If you check out your document, make changes, and check the document back in without
promoting it to the next workflow step, Control Center creates a new minor version by default.

* Major revisions mark significant changes in the documents. These are the changes that a label
or solution designer would do before forwarding the document to the approvers. Typically, new
major revisions correspond with workflow step promotions.

The administrator can choose which workflow step marks a change in your documents as a new
major revision.

3.3.5.8. Requesting Label Revisions

The label files stored inside the Document Storage are accessible using the WebDAV protocol. To get
access to the label file, the application requiring a label authenticates itself, with the user account the
application is running under. Each application runs in a specific user-space. For example, if you run the
application interactively in your desktop, it will inherit privileges of your user account.

When the application requests the file, the exact obtained revision depends on the privileges of the
user account.

Requesting HEAD Revision (Latest Available)

If you request a file without specifying any revision (you provide the file name alone), the following will
happen:

* If you have read/write access to the file (you are a designer), you will get the last revision.

* If you have read-only access to the file (you are user from a production environment), you will
get:

* The last revision (if the folder doesn't have any workflow enabled)

* The last approved-published revision (if the folder is governed by some workflow process)

Requesting Specific Revision
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To request a specific revision, provide it as a parameter after the file name.
To request revision 10 of file | abel . nl bl , you would request it as:
| abel . nl bl ?v=10

The access permissions defined on the folder where the file resides determine if you can access the
file or not. If you are not allowed to get that revision, the failure will be reported in the error message.

Requesting the Last Published Revision

To request a specific revision, provide it as a parameter after the file name.

To request the last published revision of file | abel . nl bl , you would request it as:

| abel . nl bl ?2v=P

If no file revision has been approved, the failure will be reported in the error message.
File Log

The file log contains the information about file changes and check in / check out actions. This is a
subset of information available in the file revision history.

To see the file log, do the following:

1. Select the file.

2. Click Get info button in the Toolbar.
You can also right-click the file and select Get info in the context menu.

3. Click View file log.

File log (Product label.nlbl) x
Action Data Date User Computer
Create Revision: 1 L 10/18/2016 Ancnymous
Mame: /User Guide/Product label.nlbl 11:28:26 AM
Workflow step changed  Revision: 1 10/18/2016 Anonymous

raft ->> Request approval 11:29:57 AM
Workflow: Label production approval process

Comment:

Approval request.

Workflow step changed  Revision: 1 10/18/2016 Anonymous
Request approval -» Approved 11:30:06 AM
Workflow: Label production approval process
gimmert:

Close

3.3.5.9. Restoring Deleted Files

The Document Storage contains a Recycle Bin functionality. When you delete a file, it is not actually
deleted from the system, but is just marked as deleted. When you want to really remove the file, you
have to purge it.
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To show the deleted files, to restore them or to purge them from the system use the icons in Deleted
Items group in the toolbar.

@ NOTE

To see the Deleted Items group in the toolbar, you have to enable versioning for the
document storage and must be member of Administration access role.

3.3.6. Workflows

Control Center allows you to enable workflows along with your revision control system (versioning).
Workflows let you set additional quality controls in your label printing process. Workflows include
sequences of connected steps that follow workflow logic. Every workflow has at least a starting step
and final step. There might be one or more possible promotion steps from the current step.

Using workflows, you can track the status of your label files.

When you include folders in your workflow process, the revisions users see when they request label
files depend on their access role privileges. For more information, read File Access Control.

E NOTE

The functions described in this section are available in NiceLabel LMS Enterprise.

3.3.6.1. Approval Process

Approval steps depend on the type of workflows you use. For each default workflow, NiceLabel sets
the hierarchy of workflow steps and which steps are permitted next.

Files you upload to Document Storage in workflow-enabled folders start on the Draft step. When
authors complete their initial layout and label contents, they move the file to the next step: Request
approval. When configured, Approvers receive email notifications for files they're assigned to review
and approve. Approvers can Reject files (this notifies Authors to make changes) or approve them.
Approval moves the files to the Approved step. Each workflow defines available steps and the
transitions from one step to another.

Moving files to the Approved step can require users to provide login credentials again. Re-
authenticating this way confirms the correct users are still logged in. The Two-step label production
approval process includes this re-authentication by default.
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The Approved step (or Published step in some workflows) is the final state for files. You cannot use
labels in production until they are approved and published. Operator role members (or any users with
print-only permissions) can only see files on the Approved/Published step. Authors can work on new
revisions of label files, but these changes are not visible to print-only users until their revisions reach
the Approved state.

|§ NOTE

Files only become visible to Operator access role members (print operators and print-
only users) when they are approved/published.

3.3.6.2. Label Production Approval Process

This workflow uses standard approval processes. Documents start as drafts. When ready, authors
request approval. Approvers either approve the documents or reject them. If rejected, authors can
make additional changes and request approval again. When approved, documents are published
automatically.

Operators can only see published documents. Operators have print-only permissions and can only
use the latest approved (and published) documents. If un-approved revisions exist in Document
Storage, they remain invisible to print operators.

The system documents each workflow step change. When users change steps, they must enter
mandatory comments.

DRAFT

Design is ready to be
| reviewed

REQUEST APPROVAL

g

REJECTED APPROVED (AND PUELISHED)

1

Design is rejected, updates are
necessary.

Design is approved and
published (in production)
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3.3.6.3. Two-step Label Production Approval Process

This workflow is similar to the Label production approval process workflow with a single difference.
This workflow enables the two-level approval process. Before the document is approved (and
published), two independent approvers must review and approve the document. Only after the
document has surpassed both approving steps, it becomes published.

@ NOTE

Independent approvers must be logged in Control Center as unique users.

This process can be configured to have two separate approvers (or two groups of multiple approvers)
defined for each step of the approval process.

* Request first approval: assigns unique users for the "step one" approval.

* Request final approval: assigns unique users for the "step two" approval.

To reach the approved status, the document must be approved by a unique member of both groups.

DRAFT

Design is ready to be
reviewed

REQUEST APPROVAL

1

REIECTED FIRST APPROVAL

The first approver has approved

Design is rejected, updates are
necessary.

APPROVED (AND PUBLISHED)

The second approver has approved
thedesign_ It's published (in
production).

3.3.6.4. Label Production Approval Process with Delayed
Publishing

This workflow is similar to the Label production approval process workflow with one difference. This
workflow differentiates between the Approved and Published states. When the document is
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approved, it is functionally complete, but not automatically used by the print operators yet. In some
environments the move into the final Published state must be performed with a delay. The document
might have to wait until the next work shift, or until specific date, such as after the public holidays, or
when a production order requires new label designs. You can schedule the future date and time for
the publishing to occur.

The transition to the Published state can be done manually, or automatically by the system. The state
Approved is not a final state, but is followed by:

* Published. In this case the transition into the Published state is completed by the user.

* Scheduled for publishing. In this case, the transition into the Published state is completed by
the system on a date and time as defined in the workflow.

In both cases, the change of the step is logged into the system database.

DRAFT
REQUEST APPROVAL
Usedto cancel or reschedule
automatic publishing
APPROVED
REJECTED
SCHEDULED
FOR
PUBLISHING
Design is approved but not
moved to production yet

PUBLISHED This state allows to set date

o ] when the transition to next step
Design is approved and will automatically occur
published (in production)

3.3.6.5. Enabling Workflows

To enable workflows, do the following:

1. Openthe Administration tab and click the Versioning and Workflow panel. The Document
Storage Versioning and Workflows page opens.

2. Set Workflows for document storage to Enabled. Now, the workflows are active.
3. Open the Document Storage tab.

4. Select the folder for which you would like to enable workflow control.
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5. Click the Workflow button in the Toolbar:
You can also right-click the folder and select Workflow in the context menu.

Control Center Ladmin ~ ©Help

# Overview Q=JRLIILENEN 2 Applications & Printers History ki Analytics #8 Administration

Search: v|in| Filename v || Q| |#3[x
€ o 2] & 0 a B R R Q o Q
Browse Edit Files & Folders Permissions | Revision history Workflow | Deleted items | Decommission | Previe:
~ i@ Root B B B 01 118
- @ @\
i Graphics appauth.nibl  Label_Stepi.nl- Label_Step2.nl- Label_Stepd.nl-
T Labels bl bl bl

T Solutic O Reload
¥ il Systen [ New folder
&) New project

B3 Urload files

B Folder permissions

O via e ~Enabling workflow for the selected folder.
& Chm __——_ __— Specify workflow type in the next step.
@ Check In

@ Discard Check Qut

[2) Label Report

6. Select the option you want to enable for the folder.

* Use workflow from parent folder. Select this option if the parent folder has defined the
same workflow that you intend to use. The workflow logic is inherited from the parent
folder. When you change the workflow on the parent folder, the change will propagate to
the current folder as well.

* No workflow. Select this option if you want to disable workflow control for the current
folder.

* Choose workflow. Select this option to define workflow for the current folder. You can
select the built-in workflows or a custom workflow if there is one.

3.3.6.6. Assigning workflow steps to files

Each file in the workflow-controlled folder is on a certain step. The workflow step identifies in which
workflow stage the file is currently in.

75



Document Storage

Search:

v in| Filename v || O | |4} | %

€coyRETFOAGNOE i Q
~ @@ Root

T Approval

il Delayed HE ] Edf‘
» i F_12275_EnhancedHTTPS 02 B Print
» fam F10870 B bovnload

T& F1111_Results [ Copy

T Graphics ¥ cut

il Labels [ Rename
» E zzr—'m—mTance 3 Remove o

@ RunnerTests -

= [3) Check Out Initiating workflow step change
» i@ TestDirectory Revision history
b i@ TestFolder-EF&F & Workflow step
» i@ TestFolder-F&F Q FPreview label
b [ TestFolder-RH Label Report
b i TestRename T Compare

@ TwoStep e Get info

T User guide

Selected items: 1 (4 KB)

Items: 1 {4 KB) =

When you upload a new file, or enable a workflow for the existing folder, the file is on the initial step of
the workflow. In case of built-in workflows, such as Label production workflow and Two step
approval, the initial step is Draft. Each time you change the workflow step for the selected file, the

new step is automatically assigned to the document. You can only change the steps as defined by the
workflow rules.

Change workflow step (Product label.nlbl) »®
Current step: Draft

MNext step: Request approval v

Comment:

The document is ready per specifications. Please validate and approve it.
o

S

\ Changing workflow step to the next availabe

N . step. In this case from Draft to Request
approval.

i

Cancel
;

4

Control Center allows you to simultaneously change the workflow step for multiple files in a folder.
Use <Ctrl> + click to select the files and right-click to open the context menu. Select Workflow step
option to promote the files to the next available workflow step.
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b b1 LIE

i) B B &
eani3 GS51Fixed.lbl  ITF14ascour x Cut tipLabelsWeb. -

withGraphic. bl e bl
Il Remove

Label Report
ﬁ Compare

@ Check Out
& Workflow stek

0 Get info

There are two conditions that you must meet to promote multiple files to the next workflow step:

* All selected files must be on the same workflow step.

* None of the files must be checked out during the promotion.

Once the document reaches the Approved step, it becomes visible to print-only users. These users
are usually members of the built-in access role Operator, but you can also create your own roles.

Print-only users may in certain cases be also allowed to print working versions of files. Go to
Administration > Web Clients > Edit client to set this property.

Such use is intended for solution development and testing.

3.3.6.7. Delayed Approved File Publishing (Scheduled Publishing)

To enable delayed publishing of the approved file, do the following:

1. Make sure the folder which contains the file is configured to use the workflow Label
production approval process with delayed publishing.

2. Follow the workflow steps.

3. When the document is in the Approved step, it is ready, but not available yet (not published).

|§ NOTE

The step Approved is the final step of other workflow types, but not the
workflow for delayed publishing. The final step here is Published.

4. Open the workflow step selection dialog.

5. Select Scheduled for publishing for the next step.

6. Select the date and the time when the transition from Approved to Published step must
occur.
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Change workflow step (label1.nlbl) x

Current step: Approved

Next step: Scheduled for publishing v

Workflow step "Scheduled for publishing” will be scheduled to automatically transition to workflow step "Published”.
Automatic transition time: 06/16/2016 00:00

Comment: 4 June 2016 »

This file is approved ar
Note: publishing must oc

i

i

s

T w -
©

19 20 21 22 23 24 25
26| 2T | 28| 29| 30

Workflow step log

Date User Data \J

5{'12;‘2816 Dlrafliﬂ- > Pl\eqube?t The document is already approved, but not available
3:50:29 BM Workflow: Labe l"“’ in the production yet. it will be published later on a
5/12/2016 Request approval -> Appri 1 i

3:50:38 PM Workflow: Label productiol defined day and time

OK | Cancel
A

7. Enter the comment.
8. Click OK.

Control Center will monitor all scheduled actions, and perform the workflow step change
automatically at the defined time.

3.3.6.8. Limiting Approving Privileges to the selected Folders

To change the workflow step from Request approval to Approved, Rejected, or any other defined
step:

* The user must be a member of the Approver access role.

* The Approver access role must have read/write permissions for the document storage folder
that contains the documents in approval. For details, read section File Access Control.

|§ NOTE

If there's a need to approve or reject documents without Approvers, members of the
Administrator role can also approve or reject the documents. To see how to prevent
the Administrators from approving the files, see section Preventing Administrator from
Approving Files.

You might have a situation in which only one approver can work with the documents in a folder. Or you
want to allow the approver to work with files in Folder1, but not with files in Folder2. By default, being a
member of the Approver access role grants access to all folders. The solution is to disable file access

to entire Approver role and then allow access case-by-case by adding users to other roles that have
file access.

To limit the Approver access role to the particular folder, do the following:
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10.

11.

12.
13.
14,

15.

16.

Files in folder Folder1 can only be approved by this user and no other member of the Approver role.

Open Control Center in your browser.

Go to the Administration tab.

Click Access Roles in the left-hand pane.

Click +Add. The Create new access role window opens.

Type in a name of a new role, such as AccessFolder1.

Click Save.

Go to Users in this role and click Add.

Add the users who should have the approving privilege on the Folder1.
Click Save.

Expand the Approver role.

Make sure the same user is also a member of this role.
Now the user is member of both roles, AccessFolder1 and Approver.

Log in to Control Center as the administrator.
Click on Document Storage tab.
Right-click the Folder1 folder.

Select Permissions.

@ NOTE

The Permissions option is only visible with enabled login.

For the Approver role, change permission to None. For AccessFolder1 role, change
permission to Read/Write.

3.3.6.9. Creating custom workflows

Control Center allows you to create custom new workflows. Use custom workflows to match the
specifics of labeling process in your company.

Before you decide to create and use custom workflows, analyze your labeling process and the built-in
Control Center workflows first. Consider these three available options:

* Introduce an entirely new workflow. In this case you are creating a new workflow from scratch.

Although this is the most flexible option, make sure you know your approval process well
enough before you start building a workflow. This saves your time and helps you eliminate
potential future errors.

» Edit the built-in workflows. In this case, we recommend you to duplicate and customize the most
appropriate built-in workflow. Because the steps in a duplicated workflow are already
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configured, you must only make the necessary changes to adapt the workflow steps to your
label approval process.

» Try to redesign and match your labeling process with the built-in workflows. This option makes
sure your selected workflows are fully tested by NiceLabel and functional from start.

Before you start creating or editing the workflows, get familiar with the terms used in your workflow
editor:

» Steps: Each workflow contains one or more phases called steps. During the approval process,
your documents go through the predefined approval steps. You can create, name, and order
your steps, then assign states to each step.

» States: States determine what you can do with a document during a workflow step. States
include Working, Locked, and Published (see below for detailed description of states). Users
assigned to custom workflow steps can only use the states you assign to your steps.

* Transitions: You control the workflow's direction with transitions. For example, when a reviewer
rejects someone's changes, you can direct that document back to the submitter, or forward it to
a different reviewer. All steps can transition forward or backward, except your initial step.

* Automatic transitions: Workflows can contain timed approvals that automatically transition
your documents to different steps at times you choose. You can add a delay before publication,
or prevent backlogs in documents under review by forwarding them to the next step after a set
time.

* Recipients and users: You control who gets email notifications for each workflow step.

* Enabled workflows: You can toggle workflows on and off. All workflows require Versioning to
be enabled.

S NOTE

To create customized workflows, you must have an Administration access role.

1. To create a new workflow, go to Administration > Versioning and Workflows > Workflows.

2. Ifyouare adding a new custom workflow, click +Add. The editing window for a new workflow
opens.
If you are adding a custom workflow based on one of the existing workflows, click Duplicate.
The editing window for a duplicated workflow opens. Further configuration steps are the same
as for a new workflow. The difference is that the steps are already configured.

@ NOTE

You can identify the duplicated workflow by the name. If there's a single
duplicate, the workflow's name is WorkflowName - Copy. If there are multiple
duplicates, each of them is numbered, e.g. WorkflowName - Copy (1).
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Type a Name and Description for your new workflow. Make them as descriptive as possible to
make the workflow easy to find later.

Add and configure your workflow steps. Click +Add in the Steps field to add new steps. To
edit an existing workflow step, select the step and click Edit step. The Edit workflow step
window opens:

* Type the Step name.
* Select the document State to be used in this step:

* In Working state, reviewers can check in, check out, and change the document.
Use this state for earlier approval steps when you expect multiple changes to the
document, such as draft, first level approval, etc.

* In Locked state, reviewers can only review the document — the document is read-
only. Use this state to keep documents unchanged on the current step, such as
when issuing requests for approval.

* |In Published state, the document is visible to members of all access roles. Use this
state for documents ready for use in production.

Edit workflow step

Step name Draft

State Working v

Initial step Yes

Electronic signature

C_J C_J

AH?\\: customizing email Yes
recipients

Notification email recipients |editor@efficientlabeling.com
separated by new line
comma or semicolon.

m Cancel

* Decide if your newly added step should be the Initial step of the workflow. If you select
Yes, this step becomes the first step in your newly added workflow. You can only define
one step as the initial step.

* Electronic signature is an additional security measure that prevents unauthorized users
from making changes to workflow steps.
After you enable the Electronic signature, users authorized to promote the documents
to the next workflow step must authenticate again using their Label Cloud credentials.

|§ NOTE

While authenticating again in the newly opened Label Cloud sign in
window, your session remains open. After the successful authentication,
continue promoting the document.
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@ NOTE

Electronic signature in your Label Cloud works only with Microsoft
accounts.

» Set as major revision marks the promotion of your document to the selected workflow
step as a major revision. If the document had a minor version in the preceding workflow
step, the promotion turns the current (minor) revision number into a major revision.

This options is not available if you enable the option Use only major revision numbers.
Check its status on Administration > Versioning and Workflows. Read more in section
Versioning and Workflows.

Example

Document's revision number in the "Draft" step was 3.2. After promoting the document
to the "Request for approval" step, its revision number goes to 4.0.

@ NOTE

Each workflow sequence (from "Draft" to Approved") can set the major
revision to your document only once. This means that if the document's
revision number already is a major revision, e.g. 4.0, the revision number
remains 4.0. The revision number does not go to 5.0 after promoting
your document to the next workflow step.

* For each workflow step, you can define which users receive notification emails after a
document reaches the current step. You can make the selection of users fixed or
customizable. While you are changing the workflow step for a file in the Document
Storage, the Allow customizing email recipients option allows you to add or remove
the notification email recipients.

* Notification email recipients is where you add the email addresses of the users who
are informed about the change in the workflow. Each time a document reaches the
workflow step, the listed users receives an email with the link to the document.

S NOTE

If you change the workflow step for multiple documents at once, the
listed recipients receive a single notification email. The mail includes
links to all relevant documents.

82



Workflow step changed

Browse to Control Center to review the files.

File Workflow step Comment
Access Label.nibl Approved These labels can be used in production

G§1-128.nlbl ~ Approved These labels can be used in production

Label layers.nibl Bis can be used in production.

Links to documents with
Nutrition Table.nibl h changed WOrkf|0W step BI5 can be used in production.

TRIS TS & SySTET-Oenerated MesSage.

Repeat the configuration for all of your planned workflow steps. Click Save when your are
done configuring the workflow. The new steps are listed under the Steps of your new
workflow.

Document Storage Versioning and Workflows | Configure workflow: Tomato label m Cancel
Settings
Name Tamato label
Description This is the standard temato package label.
i
Steps
+ Add Q
Step Name State Initial step Electronic signature Allow customizing ... | Notification recipie...
3 Draft Working Yes No Yes approver@tomato....
> Review Locked No No Yes approver@tomato....
> Published Published No SR \mato....
~—~./Steps of the new
“workflow

After defining the steps for your workflow, you must also define how you are going to promote
the documents to the next workflow step. Transition allows you to define the promoting
options for your documents — approvals, rejections, and time delays before publishing.

» Click +Add to define the transition to the next step in the workflow. This is the step that
the document transitions to after the authorized users give their approval. The Edit
workflow step transition window opens.

* Next step defines the transition options that follow the current step. You can
select among the existing workflow steps.

Example

When you have a Review step that decides if a Draft label should be published or
rejected, add two "next steps" - Published and Rejected.

The assigned reviewer selects Publish to make it printable, or Reject to send the
label to the Rejected step. If rejected, the author can now make corrections on the
rejected document, and promote it to the Draft step.
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Review Locked No Yes Yes

Next step Authorized profiles Automatic transition Unique user
Published Administration No No

Rejected Administration No No

* Automatic transition promotes the document to the next workflow step without
manual intervention of authorized users after a specified time period. Use this
option if you want implement time delay on your workflow step.

Example

Your label has reached the Approved step, but you want to make it available for
printing after a period of time. Add a Publishing delay step as the next step, and
enable automatic transition for this step. When authorized users promote the label
to the Publishing delay step, they define the time period after which the label
becomes published - in this case on September 26th, 2018 at 6 AM.

Examples:

Time limits. You may set a time limit for reviews by automatically transitioning
documents to the next step.

Publishing delays. Your label has reached the Approved step, but you want to
make it available for printing after a period of time.

Add a Publishing delay step as the next step, and enable Automatic transition for
this step. When authorized users promote the label to the Publishing delay step,
they define the time period after which the label becomes published.

Change workflow step (Label_Step1.nibl) x
Current step: Approved
MNext step: Publishing delay v

workflow step "Publishing delay” will be scheduled to automatically transition to workflow step "Published”.

Automatic transition time: 09/26/2018 06:00
Comment:
The Tabel becomes available at the specified time.
4
Date User Data Comment
9/24/2018, Anonymous Draft -= Review a
10:42:35 AM Waorkflow: Tomato label
9/24/2018, Anonymous Review -> Approved a
10:42:40 AM Workflow: Tomato label

OK | Cancel
P

* If you want to make sure the authorized users who promote the document through
the workflow step cannot also approve the next step transition, enable the Unique
user option. With this option enabled, the user who reviews the document must be

84



logged on to the Control Center using an account that differs from the account of
the user who is assigned to the preceding workflow step.

* Authorized roles allow you to select the access roles whose members can
promote the documents to the next step. The members of other roles are excluded
from this step.

6. After you define a custom workflow, you can apply this workflow in your Document Storage
the same way you apply the built-in workflows. See section Enabling Workflows for details.

7. To delete a workflow, select a workflow from the list and click Delete. If you want to delete a
workflow, make sure that none of the files in your Document Storage use the workflow or any
of its steps.

If you are experiencing difficulties while deleting the workflow, try deleting the individual steps
first. When deleting the used workflow step, a warning displays the names of the files that use
the workflow step you are trying to delete.

S NOTE

You cannot delete the built-in workflows.

3.3.7. Browser Extension

To enable the best experience using the Document Storage, make sure you install the extension for
your browser, when prompted so. The extension will more tightly integrate Document Storage with the
NicelLabel client. The browser extension will run NiceLabel client as RemoteApp program from the
server seamlessly and without any prompts.

Example

Double clicking the label file will open it directly in the label designer and not download the file. Saving
the label in designer will save it back to the Document Storage.

Installing the browser extension

Micelabel Control Center Extension
Micelabel Control Center Extension Client
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3.4. Applications

3.4.1. Web Applications

Use Control Center Web Applications tab to share labels and solutions from the Document Storage
with your remote co-workers or external users via the web. Web applications are useful each time you
wish to keep control over the shared labels or solutions. Sharing of centrally managed labels or
solutions makes sure that:

* Remote users always get the latest versions of approved labels and solutions.
* You can enforce user login policy.
* You keep track of printing.

* You do not run out of printer seats.

@ NOTE

Notes for users of previous Control Center versions: With the 2019 release of Control
Center, Web Applications have replaced Web Clients. With previous versions, you
created Web Clients for each shared label or solution file, and defined user names and
passwords to make these Web Clients accessible. With Control Center 2019, you
create a Web Application, define the shared label or solution file, and assign the Web
Application to a single user or to a range of users. This makes label or solution sharing
easier, faster and scalable. During the upgrade, Control Center 2019 creates a Web
Application for each existing Web Client. User that you created for legacy Web
Applications automatically convert to authorized users of Web Applications.

This section explains how to:

* Create new web applications.

* Share your web applications.

* Configure your web applications.

* Restrict application logins and printers.

* Record printing actions.

* Configure specific settings for users or groups.
* Access and use the shared web applications.

* Use file database connections in your web applications.
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3.4.1.1. Creating Web Applications

To create a new web application and make the application ready for sharing:

1.

2.

Go to the Control Center Web Applications tab, and click Add+.

Type a Name for your web application. Give your shared web application a meaningful name to
make it easy to find.

Example

Ni ce Label Sanple

Type a Description. Explain the purpose of your web application.

Example

Sanpl e of a GS1-128 conpliant | abel.

Select your web application type. You can choose to open single label or solution files or
folders containing multiple files in Documents. When you choose to open folders, you do not
need to create Web Applications for each file in the folder, you can add or remove labels you
want to print from your folder.

For Path, browse Documents in your Control Center and select the path of the solution, label
file, or folder for sharing.
You can also type the file path directly. File path must begin with "/" character.

Example

/ Label s/ Test . nl bl

If the label or solution file in your application uses a file database connection (with Microsoft
Excel or Access database), read section Using File Database Connections in your Web
Applications to ensure the accessibility of your data.

Click Save.

Your new web application is now stored on the Web Application page and ready for sharing.

You can later remove the added web applications. Select them from the Web Applications list and
click Delete.

3.4.1.2. Sharing Web Applications

Once you have created a web application, you can start sharing it:
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If you are sharing newly created web applications, go to the Authorized Users and Groups
group and click +Add Users. The Add Users window opens. If you want to add or remove
users for existing web applications, select an application from the Web Applications panel.

Share the web application with existing users or groups. Use the Search users field to type
your selection. You can also narrow your search using the drop-down list, or invite new guest

users.

* If your company uses the Azure Active Directory, you can either select specific
Organizational users or Organizational groups. To open the shared web application, all
included users must authenticate themselves using their work account credentials.

* In certain cases you want to assign your web application to a list of users. To speed up
the process of adding multiple users, list these users in a table and manually add them
to your shared web application:

1.

2.

Click the Add users manually link. This opens a new window.
Select the user group from which your list of user originates.

Paste or type your users in the Add users manually list. List the users in separate
lines.

Click Add. All your manually added users are now authorized users for the shared
web application.

X

Add users manually
Select user group: This is the group your users originate from. ’
Windows users v

Add users manually:

YourDomain\user1
YourDomain\user2

YourDomain\user3
YourDomain\user3
Paste the list of your users here.

A

m Cancel

» Click Invite new guest user to share your web application with individual users or with
users that are not listed under your company's Organizational users or groups. Type the
Invitation email address, and your message. Click OK. The new guest user receives the
invitation email for the shared application.

|§ NOTE

The invited guest users must click the link in the received invitation
email. The link takes the invited users to the Label Cloud sign up page.
After they complete the sign up procedure, they can start using the
shared web application.
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@ NOTE

NOTE: The Search users field supports incremental search. After you select
the type of users and groups, each entered character results in suggestions to
choose from.

Add users to your authorized list for new application x

Search users (1); Select user group:

applcstonssen =
Type your search string. The N

matching results list below. ’ ‘

adm

Application us)

admin

Narrow your search here. ’

Create new Application user ﬂ Cancel

Ig NOTE

If you try to share your application with more than 20 users or groups, Control
Center displays a warning when you click Save. The purpose of this warning is
to prevent accidental sharing of applications with unwanted users or groups.

The added users or groups are now listed among the Authorized Users and Groups. After you save
changes on the Web Applications page, the added users or groups receive an email with a link to your
shared web application.

To restrict access to the shared web applications, you can later remove the added users or groups
from the Authorized Users and Groups. Select them from the list and click Remove.

3.4.1.3. Configuring Web Applications

When preparing your web application for sharing, use the User Settings options:

» Status activates or deactivates the shared web application. Web applications are Active by
default. This means that users can start working with them immediately. If you want to prevent
the usage of your web application, set status to Inactive. This can be useful during the testing
phase or if you wish to postpone the use of your web application.

* Use Variable values to predefine values for certain variables that belong to the shared label or
solution.
For example, users from two different offices open the same solution file simultaneously. Main
office users have solution in French language, while branch office users have their solution in
German language.
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All users experience the same look and feel of the web application, while each user must have
application in their own language. In this case, you would define the same solution for users in

both offices and define the starting value of the language variable. You would use this variable
as afilter in the database table, displaying strings in the right language. Usually, the criteriais a
simple relation, such as field_name = variable_value.

Example

To set variable language to starting value French, use the following syntax: "language" = "French"

If a variable name includes space, also include it as a part of variable name in double quotes.

E NOTE

Check for typing errors in variable names and values. Also make sure to test the
web application before you allow the user to log in. After the solution opens, it
displays no errors if you assign values to non-existing variables.

* Enable use of non-published files in Document Storage allows you to permit the web
application users to work with versions of labels and solutions that are not published (approved).
By default, web applications only share labels and solutions that complete all workflow steps
and are marked as approved. Sharing of non-published files can be useful as part of various
testing scenarios.

3.4.1.4. Restricting Application Logins and Printers

Web Printing gives you application access control and allows you to limit the number of used printers
for your shared application.

* |IP address restriction allows you to limit the web application logins only to computers with
selected IP addresses. Type IPs into the field to allow the users to log in. The shared web
application blocks computers with non-defined IP addresses.

@ NOTE

You can define multiple IPs. Either type every address in a new ling, or use
semicolons (;) separate multiple IP addresses. To define ranges of permitted IPs,
use CIDR notation. You can convert subnet mask notation into CIDR notation
using online calculators.

Example

To allow login from any IP in range 192.168.0.1-192.168.0.254, define the range as
192.168.0.0/24.
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* Enable printer limitation to limit the number of printers that the users of this web application
can print to.

* Number of printers is the maximum number of allowed printers per user for this web
application. If users exceed this number, they can no longer print to additional printers.

S NOTE

Each used printer in the shared web application takes one license seat. This
setting makes sure you don't accidentally run out of available printer seats that
come with your NicelLabel LMS license.

3.4.1.5. Recording of Printing Actions

Record printing activities to history log keeps track of user printing actions within the shared web
application. This option allows you to start or stop the recording of printing actions in Control Center.

See the recorded activities on the Control Center History page.

|§ NOTE

Recorded information items are: label name, label quantity, printer name, variable
values, etc.

3.4.1.6. Configuring Specific Settings for Users or Groups

You can configure web application settings per single added user or group. These settings are valid
only for the specific user/group and have no impact on the general configuration of web application.

To enable and configure specific user settings, select a user or group from the list of Authorized
Users and Groups and click User Settings. The User Settings window appears.

@ NOTE

These settings override the general settings that you configure for the application.

» User settings toggle button allows you to enable specific per-user or per-group configuration
settings.

* Enable printer limitation allows you to limit the number of printers that the user or group can
print to.

* Number of printers is the maximum number of allowed printers per single user or group. If the
user or group exceed this number, they can no longer print to additional printers.
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S NOTE

Each used printer in the shared web application takes one license seat. This
setting makes sure you don't accidentally run out of available printer seats that
come with your NicelLabel LMS license.

* Variable values predefine values for certain variables that belong to the shared label or
solution. Values defined in this field (for specific users or groups) override the general values
that you define for the web application.

3.4.1.7. Accessing and Using the Shared Web Applications

After you create and share the web applications, the authorized users must complete these steps
before they can start working with their assigned applications:

1. Openyour browser and type this address:

htt p: // nyaccount . onni cel abel . cont pri nt
... where myaccount is the name of your Label Cloud.

2. Youland on the Web printing page. If you have never installed any web applications, click the
link to download and install the Web Client.

|§ NOTE

The Web Client installation is only required the first time you use the shared
web applications.

3. Login window opens. Type the user name and password that the Control Center administrator
assigns to you.

4. The signin window pops up automatically. Sign in using your Microsoft or Google account.

@ NOTE

To keep you logged in, enable the Remember me option in the Label Cloud
sign in window. The Web Client will not prompt you to sign in the next time you
open your web application.

@ NOTE

If you lose the Internet connection, you can still open your shared web
application for up to 5 days after you open the application while being online.

5. If you are authorized to use more then one web application, the Web Applications selection
window asks you which application do you want to run. Select the preferred application and
click Run web application.
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Web Applications x

Choose which web application to run

Application 1
Application 2

* Your application opens in NiceLabel Web Client.

When you close the window, Web Client signs you out from the shared web application by
default unless you select the Remember me option (see step 3).

If you selected the Remember me option while signing in, the web application window
displays your user name in the title bar. If there are other users that work with shared web
applications on your computer, you can set the web client to forget your credentials. Click
Sign out in the window title bar and the next user must sign in using their own Label Cloud
account credentials.

( "n . - O X
s el
e

3.4.1.8. Using File Database Connections in your Web
Applications

In many cases, the labels or solutions in your shared web applications are connected to a database.
The connected database works as a dynamic data source for the object on your labels.

There are multiple locations where you can store your database. To ensure your file database
(Microsoft Access or Excel) is accessible from the shared web application, follow these rules:

1.

Your database is stored in the document storage of your Control Center. In this case, we
advise you to store your label file in the same folder as the database. When designing the label
in NiceLabel 2019, browse for the database and connect. NiceLabel 2019 automatically
simplifies the database URL in the database connection dialog.
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Database pathin |
Hras "4 documentstorage |
Y 4

Advanced Setup | | Test Connection

Open

ODEC Data Source

» Users »

Simplified database
address

2. The database is stored locally on the server that runs the Web Printing site. In this case, define
the database connection in NiceLabel 2019 as a file path on the server where the database is
stored.

3. The database is stored locally on the computer that runs the web application. NiceLabel Web
client can use your local database that has no access to the Web Printing server. To enable
this, the local database name must start with the "LOCAL_" prefix.

LOCAL Pasta.accdb
o7

"LOCAL " prefix for theL’}"/
4 i

sotararre RS

o] localfile database

Filter tables,

] Create new query Text e — : e —
posta Microsot Bxcel

MysaL

Other databases (OLE DE) Advanced Setup | | Test Connection

ODEC Data Source

Refresh Tables

oK Cancel

3.4.2. Cloud Integrations

Cloud integrations let third-party developers (integrators) use our Cloud Print APIs and Cloud trigger
APIs to interact with your label printing system. To integrate third-party developers so they can use
our APls:

* Third-party developers must register on our Developer Portal.

* You must subscribe your third-party developers in NiceLabelControl Center.

To use Cloud trigger APIs, Label Cloud APIs, and Cloud Print APIs, third-party developers must
include subscription keys from our Developer Portal in HTTP requests with custom "Ocp-Apim-
Subscription-Key" headers.

Go to Control Center > Applications > Cloud Integrations to see your active and inactive cloud
integrations.
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@ NOTE

These instructions do not apply to on-premise NiceLabel editions.

3.4.2.1. Setting up Developer Portal accounts

In Control Center:

1. Open Control Center in your browser.

2. Goto Applications > Cloud Integrations.

3. Click +Add. The Integrators page opens.

4. Type the Name of your third-party developer.
5. Click Save.

Control Center lists your new developer on the Cloud Integrations page with the status: No
developer subscribed.

@ NOTE

Your Control Center user account must have manage cloud integrations
permissions.

Instructions for your third-party Developers:

1. Openthe Developer Portal in your browser.
2. Click Sign up. The Registration page opens.
3. Enter yourinformation and click Sign up.

4. Go to your email inbox and open the email the Developer Portal sends you (check your Junk
folder).

5. Click the confirmation link in the email. Your Developer Portal profile page opens.

Your integrator is registered on the Developer Portal. To use APIs, subscribe to Cloud Print APIs and
connect subscriptions to Control Center, read the following sections.

@ NOTE

For more information, read the Cloud Triggers section of your Control Center user
guide.

95


http://developerportal.onnicelabel.com/

3.4.2.2. Subscribing on NiceLabel Developer Portal

After your third party integrators set up Developer Portal accounts, they must subscribe to specific
products to use their APIs, and then connect their subscription to Control Center. Subscriptions to
Developer Portal products are free and use primary and secondary keys for authentication. For
example, to use Label Cloud APIs, they must subscribe to the Label Cloud product on the Developer
Portal:

1. Signinto NiceLabel Developer Portal.
2. Goto Products > Label Cloud.
3. Click Add subscription.

4. Type your subscription name (if you have multiple customers, choose customer-specific
names).

5. Click Confirm.
Your developer's profile page opens with the dialogue: You have successfully subscribed to the Label
Cloud product. Try the APIs in this product now. Your developer is subscribed in the Developer

Portal, but you must connect their subscription to Control Center before your developer can use
Cloud Print API.

E NOTE

Subscribing generates two separate keys. Use them for multiple program versions
and added security. If your primary key becomes compromised, use your secondary
key and regenerate your primary key. For more information, read the Cloud Triggers
section of your Control Center user guide.

3.4.2.3. Connecting your Developer Portal subscription to Label
Cloud

After your developers register and create subscriptions on Developer Portal, you must connect their
subscriptions to Control Center before they can use our APIs in your programs.

1.  Goto Control Center > Applications > Cloud Integrations.

2. Find the integrator connected to your Developer Portal subscription, and click Copy the key.
Send this key to your third party developer.

Instructions for your third party developer:

1. Signinto NiceLabel Developer Portal.
2. Goto Products > Label Cloud.

3. Click Developer Sign Up API v1.
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4. Click Try it.
5. Type or paste your key from Control Center in the IntegratorKey box.

6. Under Authorization, select your primary or secondary subscription key (use primary by
default). For multiple customers, make sure you select your correct subscription.

7. Click Send.

When your developer clicks Send, return to Control Center > Applications > Cloud Integrations and
refresh your browser tab. Control Center lists your developer as subscribed.

Your third party developer is connected and ready to use our APlIs.

@ NOTE

Your subscription keys work for multiple developers. For transparency and security,
we recommend you create separate Cloud integrations for each developer. With this
method, you can revoke access from single developers by deleting their individual
Cloud integrations without affecting access for your other developers.

To learn more about deploying cloud triggers, read NicelLabel Automation User Guide: Cloud triggers.
To learn more about Cloud Print, read Understanding Cloud Print.

To learn more about Cloud Print API, read Understanding Cloud Print API.

3.4.3. Automation Manager

3.4.3.1. Understanding Automation Manager in Control Center

Large organizations often have multiple Automation servers running different Automation
configurations. When production problems occur, viewing Automation logs on multiple Automation
servers is inconvenient, takes time, requires remote access, and increases security risks.

Automation Manager in Control Center provides you centralized access to all configurations and
triggers running on Automation Servers on your local computers. Automation Manager in Control
Center connects to Automation Manager on your local computers, so you can make changes on local
computers instantly from your cloud or on-premise Control Center.

Automation Manager in Control Center works like your local Automation Manager, but adds computer
names so you can quickly locate your Automation configurations and triggers.
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@ NOTE

Run Automation Manager on local computers when possible. Automation Manager in
Control Center works best when you manage many Automation instances. With slow
networks, your changes may take more time to affect Automation servers installed
locally.

In Control Center, you can:
* Access all your triggers and see live trigger statuses.
» Start and stop your triggers.
* Load triggers from different configurations from your Documents in Control Center.
» Access all trigger logs to see execution details.

* See triggers with errors or warnings, and get notifications when errors occur (In Administration
> Alerts).

* Add triggers from Documents to your local computers.

* Manage users and permissions for adding, editing, viewing, and deleting triggers (In User
Management > Access Roles).

You can centrally manage all your triggers and configurations on all your computers with Automation
Manager in Control Center.

3.4.3.2. Setting trigger management permissions

You can set Automation configuration and trigger management permissions for your Automation
users in Control Center. Users with permissions can manage configurations and triggers on local
computers from Automation Manager in Control Center.

With permissions set, your users can:

» Start and stop triggers.
* Add configurations.

* Reload and remove configurations.

To enable permissions for users in Control Center:
1. Goto User Management > Access Roles.
2. Click the role you want to change.
3. In Permissions for this Role click APPLICATIONS.

4. Enable Start/Stop triggers, add/remove and reload configurations (Automation Manager,
Control Center).
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Users have now permissions to manage all triggers listed in Control Center.

3.4.3.3. Accessing all triggers

Automation Manager in Control Center provides you centralized access to all configurations and
triggers running on Automation Servers on your local computers. Automation Manager in Control
Center connects to Automation Manager on your local computers, so you can make changes on local
computers instantly from your cloud or on-premise Control Center.

The All triggers page in Control Center is your entry point for monitoring and managing all your
Automation configurations and triggers.

In Control Center, go to Applications > Automation > All triggers.

Nice Control Center

Overview Document:: NS ISLd Print Management History Analytics User Management  Administration

Web Applications Alltriggers Q | search by trigger name, server and configuration n
Cloud Integrations Manage configurations:
a
‘ Al triggers Trigger count 3 Group by configuration name  of  Group by server name  Off
et [ Trigger Name 4 Configurstion name / Type Automation Server / Logs Time passed since last event
Started
Pasta export pallets Pasta Export PE scal
Stopped O |Processed: 0 Errors: 0 File Logs
» Running File name: data.txt
Reporting_qty Reporting PE al
O |Processed: 0 Errors: 0 File Logs
» Running File name: c\Automation\2\aza.txt
Reporting_rest Reporting
O |Processed: 0 Errors: 0 File Logs

» Running File name: c\Automation\2\bbb.txt

You can:

» Access all your triggers and configurations.
* See which triggers are located on which computers and view Automation logs.
* See time elapsed since the last trigger event.
* See triggers with errors.
* Check trigger statuses:
* Running
» Stopped
» Server Offline
* See configuration names and types.
* Manage all your triggers and configurations:
» Start and stop your triggers.
» Refresh your trigger list in Control Center.

* Reload your triggers.
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* Remove your triggers.

» Copy configurations from Documents in Control Center to Automation Managers on local
computers in your network.

* Sortyour trigger list.
* Search your triggers.
» Group your trigger lists by configuration names.

Group your trigger lists list by server names.

Centralized management of all your Automation triggers saves you time, avoids system downtime,
and minimizes security risks.

3.4.3.4. Starting and stopping triggers

Automation Manager in Control Center provides you centralized access to all configurations and
triggers running on Automation Servers on your local computers. Automation Manager in Control
Center connects to Automation Manager on your local computers, so you can make changes on local
computers instantly from your cloud or on-premise Control Center.

You can start and stop triggers running on local computers connected to Automation Manager in
Control Center.

|§ NOTE

You can search for triggers by name, computer/server name, or configuration name.

Starting triggers

To start triggers in Control Center:

1. Go to Applications > Automation > All triggers.
2. Check the boxes of triggers you want to start.

3. Click Start.

Your triggers start on your computers. Automation Manager changes your trigger icons from grey to
green to show your triggers are running.
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Stopping triggers

To stop triggers in Control Center:

1. Go to Applications > Automation > All triggers.
2. Checkthe boxes of triggers you want to stop.

3. Click Stop.

Control Center

Overview Documents NJelIIEiehEN Print Management History Analytics User Management Administration

Web Applications Running Q | Search by trigger name, server and configuration n,
Cloud Integrations Manage configurations
o i 8 =
All triggers Trigger count § Group by configuration name  off ~ Group by server name  gff
UG = Trigger Name 4 Configuration name / Type Automation Server / Logs Time passed since last event
:
Reporting_rest Reporting PEF zal
Stopped ( Processed: 5 Errors: 0 File Logs 3 (minutes)
» Running File name: c\Automation\2\bbb.txt
Reporting_qty Reporting PEF al
Processed: 11 Errors: 0 File Logs 3 (minutes)
P Running File name: c\Automation\2\aaa.txt
Pasta export pallets Pasta Export PEL al
[0 | Processed: & Errors: 0 File Logs 3 (minutes)
P Running File name: data.txt

Your triggers stop on your local computers.

3.4.3.5. Adding, reloading, and removing configurations

Automation Manager in Control Center provides you centralized access to all configurations and
triggers running on Automation Servers on your local computers. Automation Manager in Control
Center connects to Automation Manager on your local computers, so you can make changes on local
computers instantly from your cloud or on-premise Control Center.

From Automation Manager in Control Center, you can add, reload, and remove configurations to and
from Automation servers on local computers,
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Adding configurations

You can load Automation configurations from Documents to Automation servers on local computers.
Running configurations on local computers helps you decentralize your automated printing
processes and allows your users to manage Automation configurations.

Users can start, stop, and modify locally-stored Automation triggers.
You can also manage all configurations from Control Center.
To add configurations to local computers:

1. Go to Control Center > Applications > Automation.

2. Click Add and select the computer to use for your Automation configuration.

@ NOTE

You must store your Automation configurations in Document Storage.

3. The Document Storage explorer window opens. Find your configuration and click Select.

Your configuration is now deployed to the Automation server on your local computer.

Reloading configurations

0 IMPORTANT

When your users change and save configurations in Automation Builder, you must
reload the configurations for them to take effect.

Reloading configurations in Control Center works the same as reloading configurations in Automation
Manager on local computers. For detailed instructions, read your Automation User Guide.

To reload configurations in Control Center;

1. Goto Applications > Automation.

2. Click Reload and select your configuration from the drop-down menu.

Your configuration reloads. Your new configuration settings now affect your printing.

Removing configurations

Remove configurations from your list in Control Center to prevent running obsolete triggers by
mistake.

To remove configurations in Control Center:
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1. Goto Applications > Automation.

2. Click Remove. Select your configuration from the drop-down menu.

@ NOTE

Removing configuration from your list in Control Center does not delete configuration
files from your local computers or Document Storage.

Your configuration is removed from your list. Triggers from removed configurations are no longer
listed.

3.4.3.6. Checking and filtering Automation logs

Automation Manager in Control Center provides you centralized access to all configurations and
triggers running on Automation Servers on your local computers. Automation Manager in Control
Center connects to Automation Manager on your local computers, so you can make changes on local
computers instantly from your cloud or on-premise Control Center.

You can check and filter Automation logs for triggers running in Automation Managers on local
computers connected to Control Center. Automation logs all activities to a local database so you can
view history and troubleshoot trigger executions.

Your Logs pane displays information for all events related to filters you apply.
To check and filter triggers in Control Center:

1. Go to Applications > Automation > All triggers.

2. Search for your trigger in your trigger list and click Logs (in the Automation Server / Logs
column).

Control Center

Overview Documents [INSSISXCUMN Print Management History Analytics User Management Administration

Web Applications Alltriggers Q x
anage configurations:
emove

Cloud Integrations

3.  Your logs window opens. You can filter your logs by:
* Time periods (predefined or custom)
* Eventlevels (Error, Warning, or Information)

» Search by event description
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Nice

Control Center

Overview Documents [INSSISSUSISN Print Management History Analytics User Management Administration

Web Applications

Cloud Integrations

Al triggers
With errors
Started

Stopped

Logs: File

-

Timestamp

(&) 6/15/2020 7:37:54 PM

Timestamp

6/15/2020 737:54 PM

6/15/2020 7:37:55 PM

6/15/2020 737:55 PM

Name

File

Description

Trigger was executed - File which ~ ~

executes the trigger is
“C:\Testing\ControlCenten\Client)...

Label:
CiTesting\Co...
Automation...

Name
Action "Open Label"

Label: Report-
Automation,

Action "Print Label” Printer: ZEBRA
TLP 2844,
Quanty:

Action
Action "Open Label"
completed

Filters

Search

zebra tip 2844

Log period
Custom -

From
5/2/2020 2:00 AM
To
6/30/2020 1:59 AM

Event level
* Error
i Warning

# Information

4. Click the arrows to the left of your log timestamps to see events and action details (like
information, warnings, and errors) in your log files.

Nice

Control Center

Overview Documents [NSSISNEUNN Print Management  History Analytics User Management  Administration

Web Applications
Cloud Integrations.
All triggers
‘With errors
Started

Stopped

Logs: Pasta export pallets

Timestamp

@wzozmnm 16 AM

Timestamp
6/1/2020 10:01:16 AM

6/1/2020 10:01:16 AM
6/1/2020 10:01:16 AM

6/1/2020 10:01:16 AM

6/1/2020 10:01:17 AM

Name

Pasta export pallets

D

11

11

1111

Description

Trigger was executed - File which ~ *
executes the trigger is
"C\Automation\CC_Automation)

Name Description

Use data filter
action for filter

*Structural
Action “Use Data Filter"

definition of
DATATXT" is
evecuted.

For each line Action started

For each line Loop value = 1

Label:

Action “Open Label"
C:\Automatio...

Printer name.
"ZEBRA R-402"
Action "Set Printer” is invalid for
set printer
action.

Filters

Search

Log period

From
6/1/2020 12:00 AM
To
6/1/2020 11:59 PM

Event level

* Error

Warning

O #* Information

Expanded log from your current day. Only logs with errors and warnings are shown.

Check your Automation logs to troubleshoot problems. If you cannot execute your triggers or actions,
Automation records error descriptions in your log files to help you identify and resolve issues.

3.5. Printers

3.5.1. Print Management

Print Management is a real-time environment for monitoring and controlling printers and workstations
in your Control Center's domain.

With Print Management, each workstation that is paired with a Control Center becomes instantly

accessible. The same goes for all of its connected printers. Every installed printer that is visible to the
Control Center can be instantly monitored and managed.
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@ NOTE

Print Management does not require you to manually establish a connection between
your workstations and the server that runs the Control Center. Each time the Control
Center or workstation comes online, Print Management statuses are updated
automatically.

Nice Control Center W - SignOut @ Help

# Overview & Documents [ Applications [EEWEEN ® History #8 Administration

& Licensed Printers ReadyToPrintGroup Q| Search by name, port and workstation
A\ Printers with Errors
[  Printer Name¥ Documents in queue  Status Workstation Port

M PrintingGroup

ReadyToPrintGrou Fax
) E 1| Decuments in queue: 0

Il Paused Printers

-+ Add printer group...

P Ready to Print

[l | Documents in queue: 0
P Ready to Print

Microsoft Print to PDF
1| Documents in queue: 0
P Ready to Print

1| Decuments in queue: 0
P Ready to Print

OKI €7300 PS5 (MS)
1| Decuments in queue: 0
P Ready to Print

Send To OneNote 16
[l | Documents in queue: 0
P Ready to Print

Send To OneNote 2013
1| Documents in queue: 0
P Ready to Print

HP Universal Printing PS

Microsoft XPS Document Writer

Uses a license seat: No

License seat reserved: No

Uses a license seat: No

License seat reserved: No

Uses a license seat: No
License seat reserved: No

Uses a license seat: No

License seat reserved: No

Uses a license seat: No

License seat reserved: No

Uses a license seat: No

License seat reserved: No

Uses a license seat: No
License seat reserved: No

Printer count: 7 View by workstation | off

3.5.1.1. Selecting Displayed Iltems

The left sidebar menu allows you to select which item type should be displayed in the central field.
Print Management monitors and manages these item types:

* Licensed printers lists which printers are using your license seats. Each printer used remains
on the Licensed Printers list for 7 days.

* View by printers: lists all visible printers connected to workstations running NiceLabel software
linked to the Control Center.

TIP

The customized view of printers is available with Label Cloud Business and Label
Cloud Unlimited.
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* Predefined status printer groups: lists printers according to their current status.
* Printers with errors lists printers reporting various errors.
* Printing now lists printers currently printing.
* Ready to print lists printers ready to be used.
* Paused printers lists printers with paused print jobs.

» Custom printer groups: printers can be grouped using various criteria under a newly created
printer group. Existing groups of printers are editable at any time. You can always add new
printers, remove existing ones, or change dynamic grouping criteria.

* + Add printer group .... opens the Add New Printer Group dialog. This dialog creates and
configures a custom printer group.

3.5.1.2. Command buttons

The following command buttons give you control over currently active print jobs on selected printers.
At least a single printer or one of the workstations must be selected to make the commands active.

* Pause: pauses current print jobs on selected printers.
* Resume: resumes the paused print job on selected printers.

* Delete documents in queue: immediately cancels and deletes the selected active print jobs.

S NOTE

You can only pause/resume printing, and delete the documents in queue for the
licensed printers.

* Reserve: prevents the selected printers from being removed after idling for more than 7 days.
This option keeps the print seat reserved for the selected printer until you manually disable it.

* Unreserve: cancels the reservation of selected printer.

* Refresh reloads the list of printers as defined by the filtering criteria.

» Settings allows you to configure the currently selected group of printers.

@ TIP
The title above the command buttons identifies which item type is currently displayed
(All Printers, All Workstations or Printer groups). The number in brackets displays the
number of shown items.
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3.5.1.3. Connected Printers and Workstations

The central field of the Print Management page lists connected printers and workstations according
to the defined criteria in the left sidebar menu.

Listed printers or workstations allow selection of individual or multiple items. All commands and
settings are done per selected items.

S NOTE

After a new printer is added to any of the connected workstations, the New printers
found notification is displayed. Newly added printers are not automatically listed right
after discovery. To list them with your other printers, click Refresh Page.

3.5.1.4. Searching and filtering

Use searching and filtering to select the printers or workstations that you wish to manage.

» Search field: allows you to find printers that match the characters as you type. Print
Management supports incremental search meaning every inserted character is used as a
search term.

Example

Printer Management searches through printer names, ports and workstations.

1. After entering "nice", only printers that contain "nice" in their name are displayed as search

results.
Printer Name & Jobs count Status Workstation Port
Epson TM-C7500 for Label LPT3:
0 print jobs
P Ready to Print

:Printer 1200dpi LPT1
1 print jobs
A

2. After entering "usb", only a printer connected via USB port is displayed.

Printer Name & Jobs count Status Workstation Port

|CAB M4 203DPI
0 print jobs

P Ready to Print

3. After entering "galaxy", only printers connected to workstations with "galaxy" in their names
are displayed.
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Printer Name 4  Jobs count Status Workstation Port

Avery 64-05 RFID 192,
0 print jobs
Printer is Paused

Avery AP 5.4 300DPI c\tmp\print.prn
0 print jobs
Printer is Paused

* Filter: filters out printers by their current print job statuses.
* Ready only: only printers ready to be used are displayed.
* Paused only: only currently paused printers are displayed.

* Error only: only printers reporting errors are displayed.

@ TIP
Terms you type in Search and Filter fields work hand-in-hand. If only search field is
used, the printers that include the entered characters are shown. Filtering works on
the entire range of connected printers or on the printers that are found using search
terms.

3.5.1.5. Bottom row

The bottom row of the central table displays the printer count and allows you to activate the View by
workstation option.

* Printer count: displays the number of currently listed printers (as filtered by the grouping
criteria).

* Show unlicensed printers: allows you to show or hide the printers which are NOT using your
license seats.

* View by workstation: activates a collapsible overview of workstations connected to the Control
Center. When expanded, all printers connected to workstation are listed.

TIP

Selection row allows you to select individual or multiple listed workstations.
Master selection allows you to select or deselect all workstations at once.

3.5.2. View by Printers

The All Printers list is positioned in the central field of your Print Management page. It lists all printers
connected to workstations paired with Control Center.
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3.5.2.1. Licensed Printers

The Licensed Printers page tells you which printers are using your license seats. Each used printer
remains on the Licensed Printers list for 7 days.

@ NOTE

If the number of used license seats exceeds the permitted number of seats, Control
Center activates a grace period. The software grants you a 30-day time extension
during which you can use a doubled number of printers. If you exceed this number,
printing is disabled on the additional printers.

By default, Control Center removes a printer from the licensed printers list if you don't use it for 7
days. If a printer is removed from the list, this frees up one license seat and allows you to use another
printer.

* Reserve printer prevents the selected printers from being removed after idling for more than 7
days. This option keeps the print seat reserved for the selected printer until you manually
disable it.

* Unreserve printer cancels the reservation of selected printers.

The Licensed Printers table contains the following fields:
* Printer: the name of the printer that is used by one of the NiceLabel applications.
* Location: computer name or IP address to which the printer is connected.
* Port: port to which printer is connected.
* Last used: time since last printing.

* Reserved: indicates if the selected printer is reserved or not.

3.5.2.2. Viewing the Printers

TIP

The functions in this section are only available in Label Cloud Business and Label
Cloud Unlimited.

Each row header in the central field table can be used to customize how listed items are sorted.

109



@ TIP
The Selection row allows you to select individual or multiple listed printers. If a single
printer is selected, all other rows are deselected. To select multiple printers, use Shift
+ click. Master selection allows you to select or deselect all printers at once. If using
Print Management on a tablet or smartphone, clicking on multiple printers adds them
to the selection of printers.

3.5.2.3. Bottom row

Bottom row of the central table displays the printer count and allows you to activate the View by
workstation option.

* Printer count: displays the number of currently listed printers (as filtered by the grouping
criteria).

* View by workstation: activates a collapsible overview of the workstations that are connected to
the Control Center. When expanding, all connected printers to the workstation are listed.

TIP

Selection row allows you to select individual or multiple listed workstations. Master
selection allows you to select or deselect all workstations at once.

3.5.3. Custom Printer Groups

Custom printer groups allow you to organize printers that are visible in Control Center.

Grouped printers allow you to monitor and manage available printers in groups. You can group
printers statically or dynamically. This means the grouping criteria is either manually inserted or taken
from current events or printer statuses.

Click +Add printer group... to add printers to newly created groups. The central field of the Print
Management tab opens an empty list of printer groups.

* +Add printer group... button: opens the Add New Printer Group dialog.

3.5.3.1. Add New Group

* Name: sets a name for the newly added printer group.
* Description: allows you to say more about the printer group your are creating.

* Group type: allows you to choose if the printer group is static or dynamic:
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» Static printer group is a group that consists of manually selected printers. The list of
printers remains unchanged.
With this option enabled, select printers from the list of Discovered printers and add them
to the Printers in this group list. Printers can later be added or removed using the Add and
Remove buttons.

* Dynamic printer group is a group that consists of printers that match the entered search
term.

3.5.3.2. Existing Printer Groups

Existing printer groups are accessible via left sidebar navigation. After a group is defined, the printers
are listed according to user-defined static or dynamic grouping criteria.

@ TIP
Selection row allows you to select individual or multiple listed printers. If a single
printer is selected, all other rows are deselected. To select multiple printers, use Shift
+ click. Master selection allows you to select or deselect all printers at once. When
using Print Management on tablets or smartphones, clicking on multiple printers adds
them to the selection of printers.

3.5.4. Printers Tab Access Rights

You can define the Printers tab accessibility and the range of configurable options for all Control
Center access roles.

Print Management access rights are based on user authentication. After users log into Control
Center, their assigned roles define the range of granted access rights.

To define the Printers tab access rights for an access role:

1.  Go to Administration > Access Roles.
2. Select the access role and see the Application Permissions section.

3. Click the Printers tab. This is where you set user permissions.
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Application permissions

Programs Overview Documents Applications Printers History and Analytics Administration

~| View print queues
Users can view print gueues.

Manage print queues
Users can resume, pause, and delete documents in print queues.

Cenfigure printer groups
Users can create and edit print queues.

Manage printer reservations
Users can reserve and unreserve printers,

The following role permissions are relevant for the Printers tab:

* View Print Queues: defines if the user is allowed to open and use the Printers tab in Control
Center or not. This option keeps the Printers tab visible or hides it. Deselect it to prevent the
users that belong to a certain role from accessing the Print Management tab.

Missing Printers tab

L ROEWVENE L Documents Bl Analytics

Server Info

yourcluster.domain.local

9:09 AM

Operational Workstations within the Last Hour

Workstation

Mo werkstations connected.

* Manage Print Queues: defines if the user is allowed to pause, resume or delete documentsin
print queues or not. This option keeps the command buttons visible or hides them. With this
option deselected, only Refresh command button remains visible. The user can still monitor the
print queues, but has no control over them.

* Configure Printer Groups: defines if the user can add and/or configure the existing printer
groups or not. This option keeps the +Add printer group... and Settings buttons visible or hides
them.

@ TIP
+Add printer group... button allows the user to add printers to a newly created
printer group. Settings button allows the user to configure the currently
selected printer group.
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3.5.5. Understanding Cloud Print

3.5.5.1. Introducing Cloud Print

Use our Cloud Print service in Label Cloud when you have lots of labels to print but don't want waste
time installing and updating software or maintaining infrastructure. Cloud print creates a secure
connection between your printers and cloud Control Center so you can print your labels quickly
from anywhere.

Cloud printing is:
» Easy: no installation, drivers, special servers, re-configuration, or maintenance required
* Secure: authentication with APl access

* Organized: with Control Center Analytics integration to show you exactly who prints what,
when, and where.

» Accurate: test exactly how Cloud Print works in your system with a non-production sandbox
license

Cloud Print is an add-on service for Label Cloud subscriptions.

3.5.5.2. Using Cloud Print

Use Cloud Print in different ways to:

* Send print stream data directly to your printers.
* Print labels you save in document storage in Control Center.

» Store labels you save in document storage in Control Center on your printer.

Cloud Print works with:

* NicelLabel products using HTTP request actions (Automatic APl authentication).

S NOTE

For more information, read the section Configuring Triggers > Using Actions >
Data & connectivity > HTTP Request in your Control Center user guide.

» Other products using Cloud Print API (Manual API authentication):
* SAP
* Mobile apps

* Web apps
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¢ And more

|§ NOTE

Authentication is required for Cloud Print API.

Use Control Center to connect your existing printer hardware.
Cloud Print works with the following printer models:

* All Zebra printers with Link OS.

* SATO CLNX printers with firmware 1.10.0 or greater (for firmware upgrades, contact your printer
partner or reseller):

« CL4NX 205 dpi
« CL4NX 305 dpi
« CL4NX 609 dpi
« CL6NX 203 dpi
« CLBNX 305 dpi
« CT4-LX 203 dpi
« CT4-LX 305 dpi

* FX3-LX 305 dpi

To connect your printers to Label Cloud and use Cloud Print:

1. Prepare your connection: register your printer on Control Center.

2. Connect your printer to Label Cloud: configure your printer hardware.

Use Cloud Print API from NiceLabel's Developer Portal [PROBLEM LINK] to interact with your printers.

|§ NOTE

Your registration procedure depends on your printer manufacturer.

To learn more about connecting Zebra printers, read Connecting Zebra printers to Label Cloud.
To learn more about connecting SATO printers, read Connecting SATO printers to Label Cloud.

To interact with your printers connected to Cloud Print, read Using Cloud Print API.
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3.5.5.3. Connecting Zebra printers to Label Cloud

Connect your Zebra printer to Label Cloud to use Cloud Print API. NiceLabel's Developer Portal gives
you APlIs to:

* Send print stream data directly to your printers.
* Print labels you save in document storage in Control Center.

» Store labels you save in document storage in Control Center on your printer.

To connect your printers to Label Cloud, complete the following steps (Details below):

1. Prepare your connection: register your printer on Control Center.
2. Connect to Label Cloud: configure your printer hardware.

3. Complete your connection: complete your printer registration on Control Center.

Preparing your Control Center connection:

1. In Control Center, go to Printers > Cloud printers and click Add.

2. Type your printer name (this name identifies your printer in Control Center).

@ NOTE

Using spaces or special characters in your printer names may cause errors.
Remember your printer name to use later in the connection process.
3. Select your printer model from the list.

4. Copy your Server URL (under Cloud Printer settings in Control Center).

Preparing your Label Cloud connection:

@ NOTE

You can use any TCP/IP client, but NiceLabel recommends using PuTTY or Zebra
Setup Utilities (ZSU).

1. Turn on your printer and connect it to the internet.

2. Use the same local network as your printer.

3. Open your TCP/IP client to register your printer with Label Cloud's print service.
4. Configure your TCP/IP client:

a. Type your printer's local IP address.

115


http://developerportal.onnicelabel.com/
http://www.putty.org/

b. Use default port 9100 (or type the port you set).
c. (PuTTY only) Select Telnet or Raw for your connection type.

5. Establish your TCP/IP connection to your Zebra printer (on PUTTY, click Open).

Once you establish your TCP/IP connection, you are ready to send SGD commands.

Connecting to Label Cloud with SGD commands:

@ NOTE

Each command starts with: ! UL1.

E NOTE

If you don't use PuTTY, end your commands with <CR><LF> to be accepted by your
printer.

1. Setyour server URL. In your command terminal, send the following (Replace "Your Server URL"
with the Server URL you copy from Control Center):

I Ul setvar "weblink.ip.connl.location" "Your Server URL"

2. Check that your printer accepts your Cloud Print Server URL. Your printer must return the
address you send. Send:

I Ul getvar "weblink.ip.connl.location"

3. Reset your printer to apply your settings. Send:
I Ul setvar "device.reset" ""

4. Get your printer's serial number (Required by Control Center):
I Ul getvar "device. unique_id"

5. Copy your printer's serial number to complete your printer registration on Control Center >
Cloud Printers

Completing registration on Control Center:

1. Paste your printer's serial number.
2. Click Save.

3. Control Center opens a dialogue. You added your printer on Control Center, but it is not
connected yet. Control Center lists your printer in the Cloud printers section with the status:
Pending connection.
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4, Click Save.

5. Wait 1 minute and refresh your page. Control Center lists your printer in the Cloud printers
section with the status: Connected.

Your Zebra printer is connected and ready to use.

To interact with your printer connected to Cloud Print, read Using Cloud Print API.

3.5.5.4. Finding information for Zebra printers

To find your model number or serial number on your Zebra printer and authenticate it in Control
Center, follow these steps:

1. Turn on your printer and connect it to the internet.
2. Find your printer's local IP address (Consult your specific printer documentation).
3. Type your printer's IP address into your browser. Click Enter.
* Your Printer Home Page opens and lists information about your printer:

» Manufacturer (ex: Zebra Technologies)

* Model number (ex: ZTC ZT410-300dpi ZPL)

* Serial number (ex: 18J173304133)

* Name (ex: printer1)

¢ Status ( ex: READY)

Use your Zebra printer information from your Printer Home Page to continue with printer registration
and authentication in Control Center.

3.5.5.5. Connecting SATO printers to Label Cloud

Connect your SATO printer to Label Cloud to use Cloud PrintAPI. NiceLabel's Developer Portal gives
you APlIs to:

¢ Send print stream data directly to your printers.
* Print labels you save in document storage in Control Center.

» Store labels you save in document storage in Control Center on your printer.

To connect your printers to Label Cloud with Cloud Print:

1. Prepare your connection: register your printer on Control Center.

2. Connect to Label Cloud: configure your printer hardware.

Prepare to connect your SATO printer to Control Center:
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In Control Center, go to Printers > Cloud printers and click Add.

Type your printer name (used to identify your printer in Control Center).
Select your printer model from the list.

Copy your One-time connection key to use later.

Click the link to download NiceLabel Connector for your printer.

Click Save.

Control Center opens a dialogue. You added your printer on Control Center, but it is not
connected yet. Control Center lists your printer in the Cloud printers section with the status:
Pending connection.

Connect your SATO printer to Control Center. You need your USB drive and NiceLabel Connector:

On your computer:

1.

2.

Download Connector from Control Center.

Insert your USB drive (maximum USB drive size is 8Gb).
Format your USB drive to FAT32.

Copy Connector to your formatted USB drive.

Remove your USB drive.

On your printer:

Insert your USB drive.

Run Connector and press v to install.
Connector installs and your printer restarts automatically.

Remove your USB drive.

Use your printer configuration menu (Menu > 1. Configuration) to type configuration
information.

TIP

Connect your USB keyboard to your printer to quickly type your information.

Confirm your printer's description.

Type your account name (ex: your conpany 1 is the account name for the Control Center
address your conpanyl. onni cel abel . com.

Under password, type your One-time connection key

Use your printer menu navigation to press v to put your printer online
Your printer completes the connection process and displays NiceLabel Connector -
AVAILABLE.
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Your printer is configured. Control Center lists your printer in the Cloud printers section with the
status: Connected. Your SATO printer is connected and ready to use.

To interact with your printer connected to Cloud Print, read Using Cloud Print API.

3.5.5.6. Understanding Cloud Print API

Use Cloud PrintAP| from NicelLabel's Developer Portal to test how API features work in applications
you develop and to test how NicelLabel products integrate with your external business applications.
With Cloud Print API, you can:

» Send print stream data directly to your Cloud Print connected printers.
* Print labels you save in document storage in Control Center.

» Store labels you save in document storage in Control Center on your printer.

Cloud Print works with:

* NicelLabel products using HTTP request actions (automatic APl authentication).

@ NOTE

For more information, read the section Configuring Triggers > Using Actions > Data &
connectivity > HTTP Request in your Control Center user guide.

* Other products using Cloud Print API (manual API authentication):
* SAP
* Mobile apps
* Web apps

* And more

To use Cloud Print API on Developer Portal, you must:

» Set up your Developer Portal account.
* Create your free subscription for our Label Cloud product.

* Connect your Developer Portal subscription with Control Center.

|§ NOTE

Developer Portal includes auto-generated code samples in multiple programming
languages.
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Getting ready to use Cloud Print API

Setting up your Developer Portal account

InControl Center:

1. Open Control Center in your browser.

2. Go to Applications > Cloud Integrations.

3. Click +Add. The Integrators page opens.

4. Type the Name of the integrator to add (usually yourself).
5. Copy the Key.

6. Click Save.

Control Center lists your new integrator on the Cloud Integrations page with the status: No developer
subscribed.

E NOTE

Your Control Center user account must have manage cloud integrations
permissions.

On the Developer Portal:

1. Openthe Developer Portal in your browser.
2. Click Sign up. The Registration page opens.
3. Enter yourinformation and click Sign up.

4. Go to your email inbox and open the email the Developer Portal sends you (check your Junk
folder).

5. Click the confirmation link in the email. Your Developer Portal profile page opens.

You are registered on the Developer Portal. To use APIs, subscribe to Cloud Print APIs and connect
your subscription to Control Center, read the following sections.

E NOTE

For more information, read the Cloud Triggers section of your Control Center user
guide.
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Subscribing to Label Cloud on NiceLabel Developer Portal

After you set up your account on the Developer Portal, subscribe to specific products to use their
APIs, and then connect your subscription to Control Center. Subscriptions to Developer Portal
products are free and use primary and secondary keys for authentication. To use Label Cloud APIs,
subscribe to the Label Cloud product on the Developer Portal:

1.

Sign in to NiceLabel Developer Portal.
Go to Products > Label Cloud.
Click Add subscription.

Type your subscription name (if you have multiple customers, choose customer-specific
names).

Click Confirm.

Your profile page opens with the dialogue: You have successfully subscribed to the Label Cloud
product. Try the APIs in this product now. You are subscribed in the Developer Portal, but you must
connect your subscription to Control Center before you can use Cloud Print API.

@ NOTE

Subscribing generates two separate keys. Use them for multiple program versions
and added security. If your primary key becomes compromised, use your secondary
key and regenerate your primary key. For more information, read the Cloud Triggers
section of your Control Center user guide.

Connecting your Developer Portal subscription to Label Cloud

After you register and create your subscription on Developer Portal, you must connect your
subscription to Control Center before you use Cloud Print APIs in your programs.

1.

2.

Go to Control Center > Applications > Cloud Integrations.

Find the integrator connected to your Developer Portal subscription, and click Copy the key.
In a new tab, Sign in to NiceLabel Developer Portal.

Go to Products > Label Cloud.

Click Developer Sign Up API v1.

Click Try it.

Type or paste your key from Control Center in the IntegratorKey box.

Under Authorization, select your primary or secondary subscription key (use primary by
default). For multiple customers, make sure you select the correct subscription.

Click Send.
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Return to Control Center > Applications > Cloud Integrations and refresh your browser tab. Control
Center lists your user status as subscribed. You are connected and ready to use Cloud Print API.

Using Cloud Print API

Printing or recalling labels saved in Document Storage with Cloud Print API

Once you subscribe to Label Cloud APl on Developer Portal and connect your subscription, you can
test how printing works for labels stored in Document Storage in Control Center using API:

1.

Sign in to NicelLabel Label Cloud API Developer Portal.

2. Go to APIs > Cloud Print API and click v1. The Cloud Print API page opens.

3. GotoPrintand click Try it.

4. Type your printer name (Cloud printers must be connected to Control Center).

5. Select your content type (JSON or XML, your request body changes).

In your Request body:

1. Type the file path for your label in Document Storage in Control Center. You can use label files
(.nlbl) or solutions (.nsin). For solutions, define your label name:
Label:
"FilePath": "/ Mol der/ MyLabel . nl bl ",
Solution:
"FilePath": "/Label s/ Your Sol ution. nsln",
Label name:
"Label Name": "YourLabel 1",

2. Optional: define your file version.

3. Type the quantity of labels to print. To print 3 labels, type:
"Quantity": 3,

4. Optional: if your labels have variables, add them here (for simple labels or test prints, delete
this section).

5. Optional: to use specific printer settings, Base64 encode your devmode.

6. Click Send.

Your printer prints your label.
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Storing labels on your printer with Cloud Print API
Test how storing labels in your printer's internal memory works using API:
1. Signinto NicelLabel Label Cloud API Developer Portal.
2. Goto APIs > Cloud Print APl and click v1. The Cloud Print APl page opens.
3. Goto Store and click Try it.
4. Type your printer name (for Cloud printers connected in Control Center).

5. Select your content type (JSON or XML, your request body changes).

In your Request body:

1. Type the file path for your label in Document Storage in Control Center. You can use label files
(.nlbl) or solutions (.nsIn). For solutions, define your label name:
Label:

"FilePat h": "/ MFol der/ MyLabel . nl bl ",

Solution:

"FilePath": "/Label s/ Your Sol ution.nsln",
Label name:

"Label Name" : " YourLabel 1",

2. Optional: type your file version.

3. Optional: type your stored label name (used on your printer if you generate your own recall
stream).

@ NOTE

If you recall stored labels with the Print action, delete this setting to store your
label with their default label names.

4. Required: type your printer store variant (your printer memory).
5. Optional: define Base64 encoding (for simple labels or test prints, delete this section).
6. Click Send.

Your label is stored on your printer. To recall your stored label, use the Print action (see previous
section).

@ NOTE

You can generate your own recall steams and send them to your printer using the
SendData action. You can also use the Print action to generate recall streams, but your
labels must be saved in Document Storage.
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Listing Cloud Printers with Cloud Print API

When you develop applications where users print labels with cloud printers, use APl to get a list of
your registered cloud printers and their statuses (you can see Cloud Printers in Control Center under
Printers > Cloud Printers):

1. Signin to NiceLabel Label Cloud API Developer Portal.
2. Goto APIs > Cloud Print APl and click v1. The Cloud Print APl page opens.
3. Goto Printers and click Try it.

4. Click Send.

In Response content, Developer Portal displays your registered cloud printers in JSON format.

Sending data to your printers with Cloud Print API

If you use applications that generate print streams, store streams, or recall streams, use the SendData
action to send your generated streams to your printers. The SendData action sends generated
streams or raw commands in printer-specific language. Base64 encoding ensures your labels print
special characters correctly.

@ NOTE

Printing with this process may require printer drivers.

1. Signin to NiceLabel Label Cloud Developer Portal.
2. Goto APIs > Cloud Print API and click v1. The Cloud Print APl page opens.
3. GotoSendData and click Try it.

4. Type your printer name (for Cloud printers registered in Control Center).

In your request body, send Base64 encoded data to your printer:

1. Generate your stream (in Designer, print your label to file, or use your own external
applications to generate .prn files.).

2. Convert your stream to Base64 (for testing, you can use online conversion tools).
3. Paste or type your Base64-encoded stream into your request body.

4. Click Send.

Your request sends. If you encoded a label print stream, your printer prints your label.
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3.6. History

3.6.1. History

Control Center offers a detailed history log of all events in the printing system and a flexible sorting
and filtering system, which assists you in finding the events that you're interested in. The events can
either be displayed on a single list or split into the following categories:

* Printing. All events directly related to print jobs.

* Errors. Reported printing errors.

» System. Audit log with documentary evidence of past activities.
* Alerts. List of issued alerts in printing system.

» All Activities. Aggregated overview of all past activities.

3.6.1.1. Data Filtering

A default view to the collected data is one day of event history. You can quickly adjust the time-frame
using the combo box selection with predefined time intervals.

After selecting the preferred time interval, the page updates and shows the events from selected
interval. If the items do not fit on a single page, you can navigate to the next pages with results.

History All Activities History
> Printing
> Errors

. Type Module Workstation User
» System No activities could be found using the current filter,
> Alert: Custe
> All Activities . .

Time selection from ’
predefined time intervals [

Define filter

Date Range Day -

Type: Al M

Module: All -

Status: All T

Workstation: All -

User: All M

Information: |

Details: |

Execute Filter Cancel

\ ~ Filtering Categories for
All Activities panel
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To further drill-down for the data of interest and define a custom filter click Define filter. You may
create afilter on other parameters, such as print application names, workstation names, user names,
label names, values of variables and many more.

3.6.1.2. Printing

Printing History page displays the list of past printing events. Each event includes information
regarding source application of the print job, workstation and user who initiated it, which printer it was
executed on, when the event took place, and action status.

Printing History offers a comprehensive log of all printing activities performed in the past. The filter
enables you to either choose from a preset selection of past time intervals, or to use an advanced
filter using which you can accurately pinpoint the printing jobs you're interested in based on the
available information.

TIP

Partial search is also possible. For example, searching for "300DPI" shows all printers
that contain this substring.

Activity Details page displays detailed information about the selected printing event.

3.6.1.3. Activity Details

The following information items are displayed in the Details section:

» Status. Last-known print job status as reported through the Spooler event from Windows
operating system. The print job status is updated in real time to reflect the actual live status of
the selected print job. For more details about available statues, read section Job Statuses.

» Label Name. Specifies name of the label file that was used for printing.

» Solution Name. Specifies name of the solution which stores the file that was used for printing.

S NOTE

Solution Name is visible only if a label in a solution (.NSLN file) was printed.

* Requested Quantity. Specifies the number of labels that were instructed to print.
* Begin Print Time. Specifies the time, when the data was submitted for printing.

* End Print Time. Specifies the time, when the print job was created.

* Printer. Shows the name of the printer driver that was used for printing.

* Metadata. Shows the content of label metadata (document description) as defined by the user.
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* Workstation. Specifies name of the computer that executed printing.

* User. Specifies name of the user who executed printing. This can be user name defined in
Windows AD, or locally defined application user.

The following information is displayed in the Label Jobs section.

* Job selector. Use arrows to browse through the printed labels within a single print job.
* ID. Unique internal ID of the printed label.
* Quantity. Specifies the number of labels that were printed.

» Status. Specifies the last known status of the label within a print job as reported from the

NiceLabel printer driver. To see these statuses you have to enable the option Detailed printing

control in the printing NiceLabel application (Designer). For more details about available
statues, read section Job Statuses.

* Vision inspection. Indicates if the printed label failed or passed your vision inspection process.
The external system uses cameras to check if the printed labels meet the company's layout and

content guidelines.

ID: 1 A /
Quantity: 1

Status: Spoocled
Vision inspection: Passed

A new field for the vision inspection indication becomes visible after your external system
connects and provides feedback to your Control Center database by updating the following

tables and fields for the specific print job.
1. Select tables nan. Label Job and nan. Pri nt Job.

2. Change the Vi si onl nspect i on column values from NULL to Tr ue (label vision
inspection passed) or Fal se (label vision inspection failed).

* RF Tag. Specifies the information encoded in the Radio-frequency tag

|§ NOTE

RF tag is visible only if a smart label was printed.

* Details. Specifies a collection of variable names and their values as used in the label.
* Variables. List of variables which are connected to the label.

* Print preview. Preview of the printed label.
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3.6.1.4. Additional Details

To see more label-design related details, such as label time stamp, click the Additional Details option
in the left-hand pane.

The additional fields provide information about:

* Has Header. Provides information if the label contains header label. The header label prints
once as the very first label in the batch.

* Has Tail. Provides information if the label contains tail label. The tail label prints once as the very
last label in the batch.

* Number of sets. Specifies the number of print process repetitions. One label set contains all
labels from a single batch. The print process can be configured to print a single label set many
times (creating copies).

» Set Number. Specifies information about which set this is.

* Label Time stamp. Displays the time-stamp of the print process, when it occurred.

3.6.1.6. Errors

Errors panel provides an overview of logged printing errors in the system. Each error is displayed with
the information describing the type of error, the module that returned the error, the workstation and
user that submitted the job which returned the error, and the time of occurrence.

Clicking on one of the entries displays the information regarding the error.
Activity Details
* Status. Provides information about the event status.
* Module. Provides the name of the application reporting the data.
* Created. Specifies time-stamp when the event occurred.
* Workstation. Specifies the Windows name of the workstation reporting the event.
* User Name. Specifies the name of the user executing the event.
* Info. Provides basic event information.

* Details. Provides details about the event.

Error Details

* ID. Unique error ID.
* Module. Provides the name of the application reporting the data.

* Severity. Success, information, warning, error or question.
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* Type. Event type.
* Group. For example database errors, printer errors.
* Info. Provides general information about what caused the error.

¢ Details. Provides detailed information about what caused the error.

3.6.1.7. System

System History page provides complete documentary evidence for all activities that affect a specific
operation, procedure or event in the Control Center.

Audit records displayed on System History page include the below listed activities. Activities are
sorted by Event Types.

* Client Login. Clients logging in (Designer, Print and Web Printing clients):
» Clientlogin is also logged if incorrect password is entered.
* Clientlogin is also logged in case of insufficient permissions to start the program.
* Printer groups. Changes made in printer groups:
* Added, deleted or edited devices.
* Added or removed printer from group.
* Authentication. Changes made in authentication mode.
* Accessroles. Changes made in access roles:
* Role added, deleted or edited.
* Member added or removed from a role.
* Users and Groups. User changes and changed group settings:
* Groups added, deleted or edited.
* Users added, deleted or edited.
* WebClient. Web client changes:
* Web client added, deleted or edited.
» VersioningAndWorkflow. Changes in versioning and workflow:
* Adjusted settings.

* License. License violation on connected workstations are logged. The type of violation is
explained in the Details row.

* Document storage. Logged changes and actions on the documents that you store in your
Document Storage. The logged events include:
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* Delete files. The event of deleting files is marked with Delete. The logged event includes
the original path of each deleted file.

* Restore files. The event of restoring files back to your Document Storage is marked with
Restore. The logged event includes the original path of each restored file.

* Cut/paste files. The logged event is marked with Move, and tells you the original and the
final location for each moved file.

* Purge files. The event of permanently deleting files from your document storage is marked
with Purge. The file's original path is included.

* Check out/Check in. If you check out a file, and check the file back in, your Control Center
logs this event as Check Out/Check In.

* Restore file. The event of deleting and restoring files is marked with Restore. The file's
original path is included.

* Change folder permissions. If you change user permissions for any folder, your Control
Center logs such event as Permission changed.

* Commission/decommission. If you decommission a published file, and recommission the
file again, your Control Center logs such event as Decommission/Recommission.

» Set workflow on folder. If you apply a workflow to a specific folder, Control Center logs
such event in History as Workflow step.

To log these changes and actions, enable file versioning in your Control Center first. Go to
Administration > Versioning and Workflows, and enable Versioning for Document Storage.

TIP

License violation results from exceeded number of allowed printers or from
exceeded number of allowed NicelLabel 2019 installations per license.

3.6.1.8. Alerts

All printing activities in NiceLabel applications are reported as events. Certain event types are more
important than others, for example errors. To be able to react quickly, it is important to be notified as
soon as errors happen. You can enable the Control Center to issue email alerts with different
notification options. Alerts are created based on module, error type or severity. Based on error
importance or communication capabilities of the environment, alert action can be an SMTP email,
RSS 2.0 Feed, or an SMS message.

The Alert History section provides a list of issued alerts in the printing system. All alerts are
displayed, and the information available depends on the type of alert that was issued.

If your computer reports multiple identical label printing errors, Control Center History does not
display alerts for each of these errors. In case of repeating printing errors, you receive a new alert
every 15 minutes.
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Example

You are printing labels using your primary warehouse printer. Each minute you print one label. After
your primary warehouse printer stops printing due to malfunction, Control Center sends you the first
alert and logs the alert in History. Control Center does not send the next alert after a minute as
expected from the printing rate (1 label per minute), but after 15 minutes if your printer remains offline.

@ NOTE

The 15-minute alert delay only happens if you are continuously printing identical label
files using the same printer. If you change the label file or printer, you receive alert
immediately after your computer reports Control Center an error.

Clicking on an alert displays more detailed information about the alert's status, as well as a link to the
event that triggered the alert.

3.6.1.9. All Activities

All Activities panel presents an aggregated overview of all past Control Center activities in a given
time period. To filter out the relevant events, click Define filter to set your custom filter. The following
filtering categories are available:

* Date Range. Filters by day, week, month, or a custom time range.

* Type. Filters by label printing events or log entries.

* Module. Filters by the module used, e.g. NiceLabelDesigner or NiceLabelPrint.

» Status. Filters by print job status.

* Workstation. Filters by the connected workstation that sent the printing command.
* User. Filters by the assigned user who sent the printing command.

* Information and Details. Filters by the content that is added to the printed label using the Log
Event action on the assigned form.

@ TIP
Log Event action enables you to add basic and detailed descriptions of events that
are stored in Control Center. Information field allows you to use up to 255 characters,
while the Details field can include content with up to 2000 characters.
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3.6.2. Job Statuses

3.6.2.1. Print job statuses

Possible print job statuses are:

* Deleting: job has been deleted from the spooler.

* Deleted: spooling process has been interrupted because the print job has been manually
deleted from the print queue.

* Error: error condition on the printer - typical reason could be head opened on the printing
device.

* Error - Printing: The error condition is due to a port conflict.

* Paused: this print job has been paused.

* Printed: print job has been successfully sent to the printing device.
* Printing: printer is processing the sent print job .

* Restarting: complete print job will be resent to the printing device.

* Queued: print job is in the waiting line in the spooler and will be sent to the printing device, when
it has finished processing the previous job.

» Start spooling: print job has started to be sent to the printing device.
* Spooling: print job is being sent to the print spooler.
» Spooled: print job has been created in the print spooler without errors.

» Spool failed: while print job has been sent to the printing device, an error has occurred during
print or the job was canceled.

3.6.2.2. Label job statuses

@ NOTE

You have to use NicelLabel printer driver in order to see label job status. If you do not
use NicelLabel printer driver, the final label status is "Spooled".

The possible label job statuses are:

* Preparing: data for label job is just being processed and will be sent into print spooler.

» Send failed: label job could not be sent to the printing device successfully. The printer has
reported a problem.

* Sent: label job has been successfully sent to the printing device.
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* Sending: label job is being sent to the printer.

* Spool failed: while print job has been sent to the printing device, an error has occurred during
print or the job was canceled.

* Spooled: label job has been created in the print spooler without errors.

3.6.3. Reprinting Labels

You can reprint all labels in the job or a selection of labels from a past printing event. The labels can be
reprinted on the original client and the original printer. If the label is saved in the Document Storage it
can also be printed by some other client (because the client has access to it in the Document
Storage) and on some other printer. If you change the target printer, make sure it has loaded labels of
the same type & dimensions.

When using the reprint functionality with remotely stored labels, the label path should be entered in
the UNC form (\\ server\ shar e\ f ol der rather than a windows syntax with a mapped drive to avoid
conflicts when the user is logged on under a different Windows account from the one that performed
the original print.

To reprint the job to another printer, do the following:

1. InHistory tab, click a printing activity to open its details.
2. Click Reprintin the left-hand pane.

3. Select the range to be reprinted and the printer to use for the reprint, and confirm your
settings.

3.6.3.1. Prerequisites for label reprinting

Label reprint action is executed on the remote NicelLabel client by NiceLabel Automation. If you do
not have NicelLabel Automation installed, reprint will not be possible.

Make sure the following prerequisites are met:

* The label file is saved in the Document Storage. This ensures that all clients have access to the
file and the label can be reprinted on any client.

¢ NicelLabel clients are activated with the same LMS license as Control Center.

* The label your are reprinting does not use global variables. If multiple labels share global
variables, you cannot reprint these labels. To read more about global variables, see section
Global Variables.

* Make sure the firewall allows inbound connection on the clients to the NiceLabel Automation
on port 56416 TCP.
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S NOTE

You cannot reprint labels with headers and/or tails. If you are experiencing issues
while reprinting certain labels, open these labels in Designer and check first if
they include header and tail.

S NOTE

For more information, see the Installation Guide.

3.7. Analytics

3.7.1. Introducing Analytics

NiceLabel Analytics in Control Center helps you monitor and analyze your entire label printing
process, giving you ways to understand what and how you print. In enterprise environments, Analytics
helps you know:

Which users print which labels from which computers with which programs on which printers using
which materials.

You can quickly sort and find information you need with these data Filters and tabs:

* Labels—file names, amounts printed, printers used, dimensions, stock numbers.
* Printers—models, amounts printed, dimensions, stock numbers.

* Printer Groups—which groups, amounts printed, dimensions, stock numbers.

* Users—user names, amounts printed, printers used, dimensions, stock numbers.

» Computers/Applications—computers, modules (Automation, Control Center, Designer, Print,
Printer Driver, SDK, Web Printing), labels printed, printers used, dimensions, stock numbers.

* Materials—label dimensions, stock numbers, amounts printed, printers used.
Use Analytics to sort, monitor, and analyze your printing process in Control Center. Analytics helps

you organize and plan your printing tasks, improve your printing processes, and find ways to decrease
your printing costs.
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Click the top of your bar graph to switch views between your Number of printed labels (1) and Number of errors
2).

To use Analytics, click the Analytics tab in your cloud-based or on-premise Control Center.

S NOTE

If your Analytics graphs and detailed lists are empty, or you experience other display
errors, try disabling your browser's ad blocker. For the best user experience,
NicelLabel suggests you disable your ad blocker or whitelist Control Center.

3.7.2. Optimizing label usage with Analytics

Know which labels print how often on which printers using which materials.

When you want to decrease labeling costs, use NicelLabel Analytics in Control Center to view and
analyze which labels you print the most so you can get the biggest savings with the smallest changes
to your labels. You can customize print date ranges and see specific label data with Filters.

To view and filter your label printing data, follow these steps:

1. Open Analytics in NiceLabel Control Center.

2. To sort your data by label file name, click the Labels tab (on your left).
To sort your data by label dimensions, click the Materials tab (on your left).
Analytics displays your bar graph and list of label printing data (toggle to display number of
errors).

3. Scroll down to view your list of file names, numbers of printed labels, and numbers of errors.

* File names contain full paths of labels you print. If your labels are parts of solutions,
Analytics displays full solution paths and your label names.

* Number of printed labels shows how many labels you print on rolls. If you print your
labels on sheets of paper, Analytics displays how many pages you use (ex: 33 pages of
labels).
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* Number of errors shows how many errors occurred.
4. Toggle the black arrows (on your left) to view label-specific detailed lists.
» Select columns to sort or drag/drop column headers to group by column data.
» Sort by printers, label dimensions (width x height)/stock number, or labels printed.

* Analytics displays your label dimension information in the following ways:

Display Example: Meaning:

10x5cm Dimensions in cm

3"x6" Dimensions in inches

30x22mm Dimensions in mm

40x7? Width is constant, but label height is variable. Your
label length depends on the amount of data in
your label.

10x7cm/A4 When you print on sheets of paper, Analytics

shows label dimensions and paper size.

30x20mm /A4 - STOCKQ9Ii9i Analytics shows your label dimensions, paper size,
and stock number.

Analytics displays label printing data from this month on your graph and list by default.
5. To see data from another print date range, use the Print date filter (on your right).
* Use the drop-down menu to select pre-defined date ranges.
» Customize your print date range by entering dates in the From and To fields.

6. To see data from specific labels, use the Label name or Label dimension filters (on your
bottom right).

» Use the drop-down menu to select/deselect specific labels.
7. Apply multiple filters at once to fine-tune your data view and find exactly what data you need.
* For more information, see Applying multiple filters in Analytics.
8. Click Export (top of page) to download your data.
* Analytics includes your applied data filters and only exports data you see.
* Your data is downloaded as an .xml file you can open in Microsoft Excel spreadsheet.

Use Analytics to view and analyze label printing data during print date ranges you select. Use this data
to optimize your printing processes and find ways to decrease your costs.

3.7.3. Optimizing printer workloads with Analytics

Know which printers print which labels and how often.
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When your printing workloads are not evenly distributed between your printers, use NicelLabel
Analytics in Control Center to view and analyze which printers print the most labels so you can more
efficiently distribute you workloads. You can customize print date ranges and see specific printer data
with Filters.

To view and filter your printer workloads, follow these steps:

1.

2.

5.

Open Analytics in NiceLabel Control Center.

Click the Printers tab (on your left).

Analytics displays your bar graph and list of printer data (toggle to display number of errors).

Scroll down to view your list of printers, labels they print, and errors.

* Number of printed labels shows how many labels you print on rolls. If you print your
labels on sheets of paper, Analytics displays how many pages you use (ex: 33 pages of

labels).

* Number of errors shows how many errors occurred.

Toggle the black arrows (on your left) to view printer-specific detailed lists.

* Select columns to sort or drag/drop column headers to group by column data.

» Sort by label dimensions (width x height)/stock number, or labels printed.

» Analytics displays your label information in the following ways:

Display Example:
10x5cm

3"x 6"
30x22mm
40x7?

10x7cm/ A4

30 x 20 mm/ A4 - STOCKO9i9i

Meaning:
Dimensions in cm
Dimensions ininches
Dimensions in mm

Width is constant, but label height is variable. Your
label length depends on the amount of data in
your label

When you print on sheets of paper, Analytics
shows label dimensions and paper size

Analytics shows your label dimensions, paper size,
and stock number

Analytics displays printing data from this month on your graph and list by default.

To see data from another print date range, use the Print date filter (on your right).

* Use the drop-down menu to select pre-defined date ranges.

» Customize your print date range by entering dates in the From and To fields.

6. To see data from specific printers, use the Printer filter (on your right).

* Use the drop-down menu to select/deselect specific printers.
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7. Apply multiple filters at once to fine-tune your data view and find exactly what data you need.
* For more information, see Applying multiple filters in Analytics.

8. Click Export (top of page) to download your data.
* Analytics includes your applied data filters and only exports data you see.
* Your data is downloaded as an .xml file you can open in MS Excel.

Use Analytics to view and analyze printer workloads during print date ranges you select. Use this data
to optimize and redistribute uneven printing workloads.

3.7.4. Optimizing printer group workloads with Analytics

Know which printer groups print which labels and how often.

When your printing workloads are not evenly distributed between your printer groups, use NicelLabel
Analytics in Control Center to view and analyze which printer groups print the most labels so you can
more efficiently distribute you workloads. You can customize print date ranges and see specific
printer group data with Filters.

To view and filter your printer group workloads, follow these steps:

1. Open Analytics in NiceLabel Control Center.

2. Click the Printer Groups tab (on your left).
Analytics displays your bar graph and list of printer group data (toggle to display number of
errors).

* Number of printed labels shows how many labels you print on rolls. If you print your
labels on sheets of paper, Analytics displays how many pages you use (ex: 33 pages of
labels).

* Number of errors shows how many errors occurred.

3. Scroll down to view your list of printer groups and labels they print.

4. Toggle the black arrows (on your left) to view printer group-specific detailed lists.
» Select columns to sort or drag/drop column headers to group by column data.
» Sort by label dimensions (width x height)/stock number, or labels printed.

* Analytics displays your label information in the following ways:

Display Example: Meaning:

10x5cm Dimensions in cm
3"x 6" Dimensions ininches
30x22mm Dimensions in mm
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40x? Width is constant, but label height is variable. Your
label length depends on the amount of data in
your label

10x7cm/A4 When you print on sheets of paper, Analytics
shows label dimensions and paper size

30x20mm /A4 - STOCKO9Ii9i Analytics shows your label dimensions, paper size,
and stock number

Analytics displays printing data from this month on your graph and list by default.
5. To see data from another print date range, use the Print date filter (on your right).
* Use the drop-down menu to select pre-defined date ranges.
» Customize your print date range by entering dates in the From and To fields.
6. To see data from specific printer groups, use the Printer group filter (on your bottom right).
» Use the drop-down menu to select/deselect specific printer groups.
7. Apply multiple filters at once to fine-tune your data view and find exactly what data you need.
* For more information, see Applying multiple filters in Analytics.
8. Click Export (top of page) to download your data.
* Analytics includes your applied data filters and only exports data you see.
* Your data is downloaded as an .xml file you can open in Microsoft Excel.

Use Analytics to view and analyze printer group workloads during print date ranges you select. Use
this data to optimize and redistribute uneven printing workloads.

3.7.5. Optimizing user workloads with Analytics

Know which users print which labels on which printers and how often.

When your printing workloads are not evenly distributed between your users, use NiceLabel Analytics
in Control Center to view and analyze which of your users print the most labels so you can more
efficiently distribute your user workloads. You can customize print date ranges and see specific user
data with Filters.

To view and filter your user printing workloads, follow these steps:

1. Open Analytics in NiceLabel Control Center.

2. Click the Users tab (on your left).
Analytics displays your bar graph and list of user data (toggle to display number of errors).

3. Scroll down to view your list of users, labels they print, and errors.
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a. Number of printed labels shows how many labels you print on rolls. If you print your
labels on sheets of paper, Analytics displays how many pages you use (ex: 33 pages of
labels).

b. Number of errors shows how many errors occurred.
4. Toggle the black arrows (on your left) to view user-specific detailed lists.
» Select columns to sort or drag/drop column headers to group by column data.
* Sort by printers, label dimensions (width x height)/stock number, or labels printed.

* Analytics displays your label information in the following ways:

Display Example: Meaning:

10x5cm Dimensions in cm

3"x 6" Dimensions ininches

30x22 mm Dimensions in mm

40x7? Width is constant, but label height is variable. Your
label length depends on the amount of data in
your label

10x7cm/A4 When you print on sheets of paper, Analytics
shows label dimensions and paper size

30x20 mm /A4 - STOCK9i9i Analytics shows your label dimensions, paper size,
and stock number

Analytics displays printing data from this month on your graph and list by default.

5. To see data from another print date range, use the Print date filter (on your right).

* Use the drop-down menu to select pre-defined date ranges.

» Customize your print date range by entering dates in the From and To fields.
6. To see data from specific users, use the Users filter (on your bottom right).

» Use the drop-down menu to select/deselect specific users.
7. Apply multiple filters at once to fine-tune your data view and find exactly what data you need.

* For more information, see Applying multiple filters in Analytics.
8. Click Export (top of page) to download your data.

* Analytics includes your applied data filters and only exports data you see.

* Your data is downloaded as an .xml file you can open in Microsoft Excel.

Use Analytics to view and analyze user printing workloads during print date ranges you select. Use
this data to optimize and redistribute uneven printing workloads.
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3.7.6. Optimizing computer workloads with Analytics

Know which computers and which programs print which labels on which printers and how often.

When your printing workloads are not evenly distributed between your computers, use NiceLabel
Analytics in Control Center to view and analyze which of your computers print the most labels so you
can more efficiently distribute your workloads. You can customize print date ranges and see specific
computer and program module data with Filters.

To view and filter your computer/module printing workloads, follow these steps:

1. Open Analytics in NiceLabel Control Center.

2. Click the Computers/Applications tab (on your left).
Analytics displays your bar graph and list of computer and application data (toggle to display
number of errors).

3. Scroll down to view your list of computers, modules, amounts of labels printed, and errors.
» Computers are computers you use to print.

* Modules are programs you use to print (Automation, Control Center, Designer, Print,
Printer Driver, SDK, Web Printing).

* Number of printed labels shows how many labels you print on rolls. If you print your
labels on sheets of paper, Analytics displays how many pages you use (ex: 33 pages of
labels).

* Number of errors shows how many errors occurred.
4. Toggle the black arrows (on your left) to view computer-specific detailed lists.
» Select columns to sort or drag/drop column headers to group by column data.
» Sort by printers, label dimensions (width x height)/stock number, or labels printed.

* Analytics displays your label information in the following ways:

Display Example: Meaning:

10x5cm Dimensions in cm

3"x6" Dimensions in inches

30x22mm Dimensions in mm

40x7? Width is constant, but label height is variable. Your
label length depends on the amount of data in
your label

10x7cm/A4 When you print on sheets of paper, Analytics
shows label dimensions and paper size.

30x 20 mm /A4 - STOCKO9Ii9i Analytics shows your label dimentions, paper size,
and stock number.

Analytics displays printing data from this month on your graph and list by default.
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5. To see data from another print date range, use the Print date filter (on your right).
* Use the drop-down menu to select pre-defined date ranges.
» Customize your print date range by entering dates in the From and To fields.

6. To see data from specific computers or modules, use the Computer or Module filters (on your
bottom right).

» Use the drop-down menu to select/deselect specific computers or modules.
7. Apply multiple filters at once to fine-tune your data view and find exactly what data you need.
* For more information, see Applying multiple filters in Analytics.
8. Click Export (top of page) to download your data.
* Analytics includes your applied data filters and only exports data you see.
* Your data is downloaded as an .xml file you can open in Microsoft Excel.

Use Analytics to view and analyze computer printing workloads during print date ranges you select.
Use this data to optimize and redistribute uneven printing workloads.

3.7.7. Applying multiple filters in Analytics

Use Analytics filters in NiceLabel Control Center to understand your label printing processes. Apply
multiple filters at once to fine-tune your data view and find exactly the data you need for analysis,
investigation, and optimization.

To apply multiple Analytics filters to your data, follow these steps:

1.  Open Analytics in NiceLabel Control Center.
Analytics displays your bar graph and list of label printing data.

2. Tofilter data from specific items, use Filters (on your right).
* You can select multiple filters at once.
» Use the filter drop-down menus to select/deselect specific items.
* You can select single or multiple items for each filter.
3. Choose from the following filters:
* Print date
* Printer
* Printer group

* Labelname

Label dimension
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* User
* Computer
* Module

* Metadata
Metadata is extra information about labels you print, stored in databases with print jobs.
Metadata you assign does not appear on your labels, but you can use it for sorting,
filtering, and other functions.
Filter your data using custom metadata tags you create for jobs in Automation. Metadata
filter tags you type in Analytics are case sensitive and must exactly match your created
tags to filter correctly.
Examples of metadata include:

¢ Printer names

User/system generated values
» Data sources

¢ Lot numbers

Example

You define lot numbers for your labels in Automation (LotNumber=444, 445, 446, etc...).
With Analytics in Control Center, you filter your data with the metadata tag
"LotNumber=444" to analyze printing data for only lot number 444.

The metadata filter helps you analyze your print process for specific metadata tags you
choose.

For more information on creating and applying metadata in Automation, see Automation
User Guide Section 5.5 Setting Label And Printer Names From Input Data.

Analytics displays user printing data from this month on your graph and list by default.
To see data from another print date range, use the Print date filter (on your right).

* Use the drop-down menu to select pre-defined date ranges.

» Customize your print date range by entering dates in the From and To fields.
With your filters applied, you can view your filtered data by selecting tabs (on your left).

* View filtered data on labels, printers, printer groups, users, computers/applications, or
materials.

To hide your filters pane and view your graph and list unobstructed, click Hide filters (on your
top right).

To remove your filters and return to your default data view click Clear all filters (on your top
right).
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Use Analytics to apply multiple filters to your printing data during date ranges you select. Use this
data to investigate, analyze, and optimize your printing processes.

3.7.8. Optimizing printing processes with Analytics

Compare stated label needs with actual usage data to find savings and optimize production.

Use Analytics in NiceLabel Control Center to see production data and investigate efficiency. Compare
how many labels you need with how many labels you print to analyze your label usage and losses,
improve your printing processes, and find ways to decrease your printing costs.

Example

You produce 1000 product units per month. For each unit produced, you need 1 label. This means
your label need is 1000 labels per month (1000 units x 1 label per unit).

Now, use Analytics to see your usage data:

1. Open Analytics in NiceLabel Control Center
2. Click the Labels tab (on your left)

3. Use the Print date filter (on your right) to see data from last month

Analytics displays your bar graph and detailed list of user printing data.
From your graph, you see you printed 1100 labels last month, 100 more than you need.

Now you can investigate this difference between your label need and your usage data. Ask why you
print more labels than you need and use the answers to find and decrease waste, errors, misprints,
and malfeasance.

You can now use Analytics to view and analyze your usage data during print date ranges you select.
Use this data to investigate, optimize production, and find ways to save by decreasing printing costs.
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4. Technical Support

4.1. Problem Solving

Control Center provides an accurate status of your printing environment and proactive notification in
case of imminent problems. When problem notification is received, either from a predefined alert or
from a user, you can use the Control Center interface for finding and solving possible problems.

This section presents typical errors that you might encounter in your environment. Recommended
steps are given that you (or your printing administrator) could take to solve the errors.

To find out if your printing environment has an error and to pinpoint the reason, please follow the
problem resolution flowchart from top to bottom:

145



Label
Error

Printer
Ermrar

Watch
Error

Deleted

User

Alertis
received rep:::ran
L 4
Check Alest - L
History ] Check Events &
Mo—pd  Check Frinters
F 3
Yes
Check Ermor Event Error Event
Info and Detail [© o

Yas .
L User action | Spooling failure ook
Frinter

Mo

¥

Check Print Job

1.Bidi
printer: still
spooling

Printed

Sent

Batch Job
Status

146



4.1.1. Possible problems

1. Error during printing: printing has been executed from labeling application, but the label is not
printed.

2. Error on printing device: out of labels, out of ribbon, head open, etc.

3. Printer status: paused, off-line, printer turned off, etc.

4. Network error: networking cable not connected, networking infrastructure error, etc.
5. User error: printing the wrong label or to the wrong printing device.

6. User action: user deletes the print job from the spooler or NicePrintQueue, etc.

4.1.2. Steps for problem resolution

1. Incase a user has reported a problem and alerts are in use, the Control Center administrator
should first check the status of his alerts and alerts defined by other users (Alerts —> History).

2. Ifanalert has been received, the administrator should click the Error Event link. If no alert has
been received, the administrator should search for an Event of type Error (Events —> Errors).
Error Event Log will open. Useful help here can be filtering and sorting feature of Control
Center.

3. Inthe Error Event Log, details about error, workstation, date and time are shown, together with
a link to that particular Event. In the Event Details window the administrator gets information
about the module from which the printing has been issued, label details and possible links to
other error events. Also, here is the Job Details link.

4. Ifthereis no Error Event, (just an ordinary Event), the Job Details should be inspected about
the Print Job status and separate label statuses (if several labels have been printed inside
printing batch (for example if counter has been used).

5. If there was no Error Event, the printing device status should be inspected (Printing -> Print
Queues —> Workstation)

Steps 1. to 4. can be used to track down possible problems 1., 5. or 6.

Step 5. can be used to track down possible problems 2., 3. or 4.

4.2. Online Support

You can find the latest builds, updates, workarounds for problems and Frequently Asked Questions
(FAQ) on the product web site at www.nicelabel.com.

For more information, please refer to:

147


http://www.nicelabel.com

Knowledge base: https://www.nicelabel.com/support/knowledge-base
NicelLabel Support: https://www.nicelabel.com/support/technical-support
NicelLabel Tutorials: https://www.nicelabel.com/learning-center/tutorials

NiceLabel Forums: https://forums.nicelabel.com/

|§ NOTE

If you have a Service Maintenance Agreement (SMA), please contact the premium
support as specified in the agreement.

148


http://www.nicelabel.com/support/knowledge-base
http://www.nicelabel.com/support/technical-support
http://www.nicelabel.com/learning-center/tutorials
http://forums.nicelabel.com/

5. Contact us

Americas

+1262 784 2456
sales.americas@nicelabel.com
EMEA

+386 4280 5000
sales@nicelabel.com
Germany

+49 6104 68 99 80
sales@nicelabel.de
China

+86 21 6249 0371
sales@nicelabel.cn

www.nicelabel.com
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